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Welcome to Working with Applications

This guide provides information on working with features common to 
different Mercury Business Availability Center applications.

How This Guide Is Organized

The guide contains the following chapters:

 Part I Working with Reports

Describes how to work with reports, including how to generate them, select 
a time range, apply filters, and share and store reports.

 Part II Configuring and Viewing User Reports

Describes how to create, administer, and view user reports, which enable 
tracking of specific performance issues relevant to your organization or 
business unit's performance monitoring needs.

Who Should Read This Guide

This guide is intended for the following users of Mercury Business 
Availability Center:

➤ Mercury Business Availability Center administrators

➤ Mercury Business Availability Center end users

Readers of this guide should be knowledgeable about navigating and using 
enterprise applications, and be familiar with Mercury Business Availability 
Center and enterprise monitoring and management concepts.
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Getting More Information

For information on using and updating the Mercury Business Availability 
Center Documentation Library, reference information on additional 
documentation resources, typographical conventions used in the 
Documentation Library, and quick reference information on deploying, 
administering, and using Mercury Business Availability Center, refer to 
Getting Started with Mercury Business Availability Center.
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1
Working in Reports

Mercury Business Availability Center reports consist of charts and tables that 
help you track and analyze the health of your monitored environment. You 
view and generate reports, and drill down and/or apply various filtering 
criteria to examine performance trends and pinpoint the cause of 
availability and performance issues.

This chapter describes: On page:

About Working in Reports 4

Understanding Common Report Elements 4

Generating Reports 7

Choosing the Tracking Range and Granularity 8

Selecting Profiles 11

Filtering Data Using Active Filters 12

Navigating Within Report Pages 16

Drilling Down Within Reports 17

Animating Report Charts with Macromedia Flash Player 17

Understanding Color-Coding in Reports 17
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About Working in Reports

Reports enable you to examine and analyze the data that Mercury Business 
Availability Center collects. When generating reports, you can specify 
various report settings, including time range and resolution, profile, 
grouping, and filters.

You can also customize reports by adding a header and a footer, by selecting 
to automatically or manually generate the report, or by customizing other 
display elements. For details, see “Customizing Reports” in Platform 
Administration.

For details on the navigation functions in Mercury Business Availability 
Center, see “Navigating Mercury Business Availability Center” in Getting 
Started with Mercury Business Availability Center.

Note: Mercury Business Availability Center presents certain reports within 
the context of transaction thresholds. For details on configuring transaction 
thresholds, see “Transaction Threshold Settings” in End User Management 
Data Collector Configuration.

Understanding Common Report Elements

The items listed in the table below are common to most report pages in 
Mercury Business Availability Center applications. Report elements specific 
to a certain application are described within that application’s 
documentation:

Item Description

Report generation button In most applications, click Generate to generate 
the report (in certain applications, reports are 
generated automatically when the page is loaded).

For details, see “Generating Reports” on page 7.
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Report time range and 
granularity

Located at the top of the report area. Displays the 
currently selected report date and time frame.

For details, see “Choosing the Tracking Range and 
Granularity” on page 8.

Report title bar Located at the top of the report.

Currently selected profile(s) Located below or beside the Profile(s) link.

Click the Profile(s) link to open the Profiles 
window and select the profile (or profiles, for the 
Multi-Profile Summary report) for which you want 
to view reports.

For details, see “Selecting Profiles” on page 11.

Currently selected filters Located below or beside the Active Filters link.

Click the Active Filters link to open the Active 
Filters window and select filter criteria. Active 
filters filter all of a profile’s reports according to 
specific criteria, for the duration of the Web 
session.

For details, see “Filtering Data Using Active Filters” 
on page 12.

Drill-down links Located to the right of the report and/or within the 
report, after report generation.

Click a link to drill down to a greater level of detail 
within a report.

For details, see “Drilling Down Within Reports” on 
page 17.

View as Graph tab Located just above the report.

Click to display a graphical representation of the 
data. This is generally the default view.

View as Table tab Located just above the report.

Click to display a tabular representation of the 
data.

Item Description
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Print Report button Click to open a window displaying a printer-
friendly version of the report.

For details, see “Printing a Report” on page 21.

Open in PDF Format 
button

Click to download report data to a file in .pdf 
format.

For details, see “Producing a Printer-Friendly 
Report in .pdf Format” on page 21.

Format in CSV button Click to format report data in .csv format.

For details, see “Saving a Report in .csv Format” on 
page 22.

Format in Excel button Click to format report data in Microsoft Excel 
format.

For details, see “Saving a Report in Microsoft Excel 
Format” on page 22.

Format in XML button Click to format report data in .xml format.

For details, see “Saving a Report in .xml Format” on 
page 24.

E-mail Report button Click to open a window from which you can e-mail 
the report to specified recipients.

For details, see “Sending a Report by E-Mail” on 
page 24.

Publish Report button Click to publish the report in .csv, .xml, or .pdf 
format.

For details, see “Publishing a Report” on page 26.

Report Repository button Click to view a list of saved reports.

For details, see “Saving a Report to the Report 
Repository” on page 29.

Item Description
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Generating Reports

You generate reports and modify the information that Mercury Business 
Availability Center displays, to pinpoint problem areas. For example, you 
suspect that a certain location is not performing well enough, so you 
generate a report that is organized by location.

Certain reports are initially generated automatically, whereas for others you 
must specify report criteria and generate the report manually. For details on 
setting reports to be automatically generated, see “Configuring Report 
Generation Settings” in Platform Administration.

To generate a report manually:

 1 Select a report.

 2 Specify report criteria, including time range and granularity, and profile, 
grouping and filter settings. Note that report criteria differ for each 
application.

 3 Click the Generate button.

Tab menu Move the mouse over a tab to display a grey arrow. 
Click the arrow to display the list of available 
options for that tab.

For details, see “Navigating Mercury Business 
Availability Center” in Getting Started with Mercury 
Business Availability Center.

Application tab overview 
page

Click a tab to display the application tab overview 
page.

For details, see “Navigating Mercury Business 
Availability Center” in Getting Started with Mercury 
Business Availability Center.

Item Description
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Choosing the Tracking Range and Granularity

When generating a report, you choose the tracking range and granularity in 
which the report is displayed.

To choose a tracking range and granularity:

 1 From the tracking range list (labeled View), select a tracking range. You can 
display reports by:

➤ custom range

➤ hour, day, week, month, quarter, year

➤ past hour, past day, past week, past month, past quarter, past year

➤ week to date, month to date, quarter to date, year to date

➤ previous week, previous month, previous quarter, previous year

➤ last <definable time period>

Note: Not all reports include all the above tracking ranges.

 2 Select:

➤ Hour, Day, Week, Month, Quarter, or Year to generate the report in that 
time range. Then choose either the start date and time or the end date 
and time. Mercury Business Availability Center updates the other 
accordingly. Continue to the next step.

➤ Custom to generate the report for a time range whose start and end date 
you want to manually select. Then choose both a start and end date and 
time. Continue to the next step.

➤ Last to generate the report for the last hour, day, week, month, quarter, or 
year, every hour, day, week, month, or quarter (relevant only in Service 
Level Management. For details, see “Filtering Results by Tracking Period” 
in Using Service Level Management).
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➤ Any of the other options to view the time range relative to the current 
date and time. (If you select one of these options, and then make changes 
to the start and end dates, the View box updates the time range.) To 
continue, skip to step 7. 

 3 To specify a starting date and time, click the start date link (labeled From). 

To specify an ending date and time, click the end date link (labeled To). 

Mercury Business Availability Center opens the calendar window.

 4 Use the calendar to select the start or end date and time for the report. 
Choose a month, year, and time from the lists, and click a date in the 
calendar table.

Use the forward and back arrows on either side of the selected month to 
move the time period forward or back by a month.

 5 Click OK to accept the date you chose.

Click Reset to reset the calendar to the default day, month, year, and time.

Click Cancel to close the calendar without changing the starting time.

 6 Use the forward or back arrows as required to move the selected time period 
forward or back by the period of time specified in the time range list. If a 
custom time range is selected, Mercury Business Availability Center moves 
the time period forward or back by the current custom time range.

 7 For reports that are divided by time units, you can select report granularity. 
From the granularity value and granularity unit lists (labeled Every), select 
the granularity for the report. The available granularity units (minute, hour, 
day, week, month, year) differ depending on the selected time range, and 
the granularity values differ per granularity unit.

The granularity determines how many measurement samples are displayed 
in the report per time interval. By default, reports are limited to a maximum 
of 32 samples. Thus, for example, if you select the “Day” time range and the 
“minutes” granularity, since there are 1,440 minutes in a day and a 
maximum of 32 samples on a chart, the granularity ranges from “every 
45 minutes” (1440/32=45) to “every 59 minutes” (above 59 minutes, you 
use the “hour” granularity unit).
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Additional examples:

➤ If you select the “Day” time range and a granularity of “every 1 hour,” 
the report is displayed using 24 samples (1 hour x 24 = 1 day).

➤ If you select the “Month” time range and a granularity of “every 1 week,” 
the report is displayed using 4 samples (1 week x 4 = 1 month). 

You can modify the allowed number of samples in reports in the 
Infrastructure Settings Manager. To do so, select Admin > Platform > Setup 
and Maintenance > Infrastructure Settings, click Applications, select End 
User/System Availability Management, and locate the Max Data Points in 
Report parameter entry in the Data table. Modify the value to the required 
amount.

For details on using the Infrastructure Settings Manager, see “Infrastructure 
Settings” in Platform Administration.

Note: 

In certain reports, the selected time range is displayed along the x-axis. 
Mercury Business Availability Center breaks down the time range according 
to segments that differ depending on the selected time range. For details on 
how Mercury Business Availability Center breaks down each time range in 
reports where time is displayed along the x-axis, see “Report Times” in 
Reference Information.

Depending on the time range you select, Mercury Business Availability 
Center generates reports using either raw data or aggregated data. A note is 
displayed in the report when aggregated data is used. For details on how 
Mercury Business Availability Center determines when to use aggregated 
data, see “Data Aggregation” in Reference Information.
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Selecting Profiles

You select the profile (or profiles, when viewing the Multi-Profile Summary 
report) for which you want to view and analyze reports. The first time you 
log into Mercury Business Availability Center, the first profile in the list is 
displayed (profiles are listed alphabetically). In the Multi-Profile Summary 
report, Mercury Business Availability Center displays all profiles. When you 
log in on subsequent occasions, Mercury Business Availability Center 
displays the last profile (or profiles, in the Multi-Profile Summary report) 
that you selected.

Profiles are classified by type:

➤ Business Process Monitor

➤ Client Monitor

➤ SiteScope

Depending on the report you are viewing, Mercury Business Availability 
Center displays the appropriate profile type in the Profiles window.

To select a profile:

 1 Click the Profile(s) link at the top of the report to open the Profiles window.

 2 Select a profile. 

If you are working in the Multi-Profile Summary report, select multiple 
profiles up to a maximum of 10.

 3 Click OK.
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Filtering Data Using Active Filters

Active filters enable you to filter specific components from reports, for the 
duration of a Web session. You can then pinpoint problem areas as well as 
focus on specific areas that you have already determined to be problematic. 
Different components appear, depending on the type of report you choose 
to view.

Note: Mercury Business Availability Center administrators can configure 
filters that apply to all users for all sessions. For details, see “Configuring 
Report Filters Globally” in Platform Administration.

Using Active Filters

Follow the procedures below to work with Active Filters.

To use Active Filters:

 1 Click the Active Filters link at the top of a report to open the Active Filters 
window.
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The tabs can display any of the following components, depending on the 
application and report:

Tab Description

Advanced Categories and filters defined on the Measurement 
Filters page for Real User Monitor. For details, see 
“Using the Real User Monitor Active Filters” in Using 
End User Management.

CIs Configuration items appearing in Dashboard 
reports. For details, see “What Are Configuration 
Items?” in Working with the CMDB.

Desktops Hosts running Client Monitor. For details, see 
“Desktop Performance Report” in Using End User 
Management.

Raw Data Measurements Raw data measurement appearing in Raw Data 
reports. For details, see “Raw Data Over Time 
Reports” in Using Dashboard.

End Users Specific user names, host names, or single IP 
addresses. For details, see “Using the Real User 
Monitor Active Filters” in Using End User 
Management.

End User Groups End-user groups configured in Monitor 
Administration. In certain reports you can also filter 
the end-user groups according to wildcard 
expressions, or by entering a range of IP addresses. 
For details, see “Using the Real User Monitor Active 
Filters” in Using End User Management.

Event Source Source of the event.

Events Events by type. For details, see “Using the Real User 
Monitor Active Filters” in Using End User 
Management.

Groups Groups of host machines running Business Process 
Monitors.
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KPIs Key Performance Indicators can be filtered for the 
KPIs Over Time reports. For details, see “KPIs Over 
Time Reports” in Using Dashboard. Only the status-
based or value-based KPIs are listed depending on 
your choice.

Locations Locations of host machines running Business 
Process Monitors.

Monitor SiteScope monitor types.

Pages Pages and groups of pages configured in Monitor 
Administration. For details, see “Using the Real User 
Monitor Active Filters” in Using End User 
Management.

Servers Servers displayed in the report according to the 
wildcard expressions you enter. For details, see 
“Using the Real User Monitor Active Filters” in Using 
End User Management.

Severity Severity label specified in the alert scheme. 

Source Source of alert. 

Target Name of the server machines monitored by 
SiteScope.

Contains a Target box where you can insert a regular 
expression to filter the data by target. By default, the 
Target box contains an asterisk (*), signifying a 
wildcard.

Thresholds Reports can be filtered by the performance, or 
availability of the pages, transactions, end users, or 
servers in the report. For details, see “Using the Real 
User Monitor Active Filters” in Using End User 
Management.

Tab Description
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 2 From the appropriate tab, select the components to include in reports, or 
clear items to exclude them from reports.

To select all choices on a tab, click All. To clear all selections, click None. To 
invert your selection(s), click Invert.

You must select at least one item from each tab.

 3 Click OK to save the filter settings and close the Active Filters window.

Click Cancel to close the Active Filters window without saving the changes.

The active filters you choose remain in effect for all reports for the duration 
of the Web session. 

If desired, you can clear all active filters simultaneously.

To clear all active filters:

Click the Clear All link to regenerate the report unfiltered.

Limitations

➤ If all transactions are removed from a specific location, that location still 
appears in the Location tab.

Transactions Recorded business processes run by Business Process 
Monitors, or transactions and groups of transactions 
configured in Monitor Administration for Real User 
Monitor.

Note: You can choose one transaction only in the 
Triage Raw Data report. For details, see 
“Triage Raw Data Report” in Using End User 
Management. 

Type Type of alert.

Tab Description
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➤ When displaying the Response Time over Time and Availability over Time 
charts, Mercury Business Availability Center can display up to 100 
transactions simultaneously. If a profile has more than 100 transactions, 
Mercury Business Availability Center automatically selects the first 100 
transactions listed on the Transaction Ordering page. To select different 
transactions to view, modify the active filters. To change the order in which 
transactions appear, you modify their order in the Transaction Ordering 
page. For details, see “Modifying Transaction Order” in Application 
Administration.

➤ If the Mercury Business Availability Center databases are installed on an 
Oracle Server, wildcard expressions used in active filters are case sensitive. 
On an MSSQL Server, wilcard expressions used in active filters are case 
insensitive. For further details on the Mercury Business Availability Center 
databases, see “Introduction to Preparing the Database Environment” in 
Preparing the Database Environment.

Navigating Within Report Pages

Mercury Business Availability Center divides a table of data or a list of 
reports into pages. You move from page to page by clicking the relevant 
button:

➤ To view more reports, click the Next page or Last page buttons.

➤ To view previous reports in the list, click the Previous page or First page 
buttons.

When you click the Sort button in a report, Mercury Business Availability 
Center displays the first page of the report list, sorted by the column you 
chose.

When you click the Generate button in a report, Mercury Business 
Availability Center displays the first page of the report list.

The number of rows of table data that are displayed in a page depends on a 
setting in the Infrastructure Settings Manager. To customize this setting, 
contact Mercury Customer Support.
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Drilling Down Within Reports

Within a report, you click the drill-down links to view a greater level of 
detail. Drilling down enables you to more pinpoint performance issues 
related to a specific report element, for example, a specific transaction, 
location, group, or time frame. The drill-down links are located within a 
report.

Note that clicking the drill-down links automatically updates the active 
filters and time range setting.

Animating Report Charts with Macromedia Flash Player

You can choose to use Macromedia Flash Player to render report charts, to 
control the flow of information and add interest to your reports. 

Your users must have Flash Player installed on their machines. If they do 
not, the browser displays a message containing instructions on 
downloading Flash Player.

The reports that support the use of Flash Player are those that include charts 
(most Dashboard, Service Level Management, and Real User Monitor 
reports). However, scatter charts are not supported.

For details on customizing Mercury Business Availability Center charts to be 
displayed with Flash Player, contact Mercury Customer Support.  

Understanding Color-Coding in Reports

Mercury Business Availability Center uses color coding in reports to organize 
data in a meaningful way, and make reports more readable.

Use the legend that appears in a report to get a basic description of the color 
coding used in the report. For detailed information about a specific report 
and how to interpret the color coding used, refer to that report’s 
documentation.
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2
Sharing and Storing Reports

Mercury Business Availability Center enables you to share and store reports 
using various methods, including printing, exporting to other formats, and 
storing in a repository for future access.

About Sharing and Storing Reports

Mercury Business Availability Center provides the following functionality 
for sharing and storing reports that you generate:

➤ sending a report to a printer

➤ saving a report in .pdf format

➤ formatting a report in .csv or .xml format

➤ exporting a report, by sending it by e-mail, publishing it, or saving it to the 
report repository

This chapter describes: On page:

About Sharing and Storing Reports 19

Printing Reports 20

Formatting Reports 22

Exporting Reports 24
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Depending on the type of report you are viewing, some or all of the 
following buttons are available: 

Printing Reports

You can send a report directly to a printer or produce a printer-friendly 
report in .pdf format.

This section includes the following topics:

➤ “Printing a Report” on page 21

➤ “Producing a Printer-Friendly Report in .pdf Format” on page 21

Category Click to...

produce a .pdf format file. For details, see “Producing a 
Printer-Friendly Report in .pdf Format” on page 21.

 send a report to a printer. For details, see “Printing a 
Report” on page 21.

produce a .csv format file. For details, see “Saving a Report 
in .csv Format” on page 22.

produce an Excel format file. For details, see “Saving a 
Report in Microsoft Excel Format” on page 22.

produce an .xml format file. For details, see “Saving a 
Report in .xml Format” on page 24.

send a report by e-mail. For details, see “Sending a Report 
by E-Mail” on page 24.

publish a report with updated data. For details, see 
“Publishing a Report” on page 26.

save a report to the report repository. For details, see 
“Saving a Report to the Report Repository” on page 29.
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Printing a Report

Tip: Before printing, ensure that printer settings are set to print the selected 
frame, and not to print frames as laid out on screen.

To obtain optimal print results if you are using Microsoft Internet Explorer, 
enable the Print background color and images option (Tools > Internet 
Options > Advanced tab > Printing).

To print a report:

 1 Click the Printer-Friendly Report button to open a window displaying the 
printer-friendly report.

 2 To print the report, click the browser’s Print button, or right-click on the 
page and select Print.

Producing a Printer-Friendly Report in .pdf Format

The following procedure explains how to produce a printer-friendly report 
in .pdf format.

To produce a report in .pdf format:

 1 In any report, click the Open in PDF Format button to display the report in 
.pdf format in a new browser window.

 2 Follow the Adobe Acrobat instructions to print or save the file in your local 
file system. 
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Formatting Reports

You can format a report in .csv, Excel, or .xml format.

This section includes the following topics:

➤ “Saving a Report in .csv Format” on page 22

➤ “Saving a Report in Microsoft Excel Format” on page 22

➤ “Saving a Report in .xml Format” on page 24

Saving a Report in .csv Format

The following procedure explains how to save a report in .csv format. Only 
those reports that support this functionality include the CSV button.

To save a report in .csv format:

 1 In a report, click the CSV button to open the report in a new browser 
window.

If your browser does not display the .csv file in a new window (for example, 
if you do not have Microsoft Excel installed on the machine), follow your 
browser’s instructions to view the file or save it to disk.

 2 Select File > Save As, choose a path, file name, and file format type 
(Microsoft Excel, .csv, and so forth), and click Save.

Note: For the CSV formatted report to display correctly, the comma (",") 
must be defined as the list separator. In Windows, to verify or modify the list 
separator value, open Regional Options from the Control Panel, and on the 
Numbers tab ensure that the comma is defined as the List Separator value. 
In Solaris, you can specify the list separator in the application that opens 
the CSV file.

Saving a Report in Microsoft Excel Format

The following procedure explains how to save a report in Microsoft Excel 
format. Only those reports that support this functionality include the Excel 
button.
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Note: Microsoft Office Excel 2002 or later must be installed on the client 
machine from which you are generating the report.

To format a report in Excel format:

 1 In a report, click the Excel button. 

 2 Choose whether you want to display the report or save it. To save the file, 
click Save, and in the browser that opens, choose a path and file name and 
click Save.

Any tooltips in the report are converted to comments in Microsoft Excel. To 
view all the text of a large tooltip, edit the comment by right-clicking the 
cell and choosing Edit Comment. Enlarge the box by dragging a corner: 
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Saving a Report in .xml Format

You can save a report in .xml format to send to users, or to insert into other 
reports. The data in the XML file is not updated. Only those reports that 
support this functionality include the XML button.

To open a report in .xml format:

 1 In any of the reports that support this functionality, click the Open in XML 
Format button to open the report in a new browser window.

 2 Select File > Save As, choose a path, file name, and .xml file format type and 
click Save. This step is optional.

Tip: To extract HTML code from the report, save the file as HTML, open the 
file in an HTML editor, and copy the relevant table into the target file. 

Exporting Reports

You can send a report by e-mail, publish a report with updated data, or save 
a report to the report repository.

This section includes the following topics:

➤ “Sending a Report by E-Mail” on page 24

➤ “Publishing a Report” on page 26

➤ “Saving a Report to the Report Repository” on page 29

Sending a Report by E-Mail

The following procedure explains how to send a report by e-mail.

To send a report by e-mail:

 1 Click the E-mail this Report button to open the Mail Details window.

 2 Change the default subject, if required.
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 3 Specify one or more e-mail addresses in the Recipients box. Separate 
multiple addresses using a semi-colon.

 4 Specify a reply-to e-mail address in the Reply-to box.

If required, an e-mail address can be configured to appear in the Reply-to 
field by default. This is done in the Infrastructure Settings Manager. Select 
Admin > Platform > Setup and Maintenance > Infrastructure Settings, click 
Foundations, select Business Availability Center, and locate the Default 
Reply-To Address entry in the Business Availability Center Interface - Display 
table. Update the value as required. 

For details on using the Infrastructure Settings Manager, see “Infrastructure 
Settings” in Platform Administration.

 5 If required, type a comment in the Comments box.

 6 Specify whether you want to send the report as:

 a HTML mail. The report is displayed in the e-mail client (the e-mail client 
must support, and be configured to display, HTML).

• Select Include Images to include all report resources (for example, 
graphics) in the e-mail. 

• Clear Include Images so the images are not included in the e-mail. In 
that case, all report resources (for example, graphics) are located on 
Mercury Business Availability Center servers. A network connection to 
Mercury Business Availability Center is required to view the images in 
the report.

 b HTML attachment. The report is displayed in a browser (the browser 
must support the MHT format—Microsoft Internet Explorer supports 
MHT format, for example). 

• Select Send as Internet Explorer Archived HTML. The report is 
displayed in a browser (the browser must support the MHT format—
Microsoft Internet Explorer supports MHT format, for example). All 
report resources (for example, graphics) are included in the e-mail.

• Select Zipped attachment to send the attachment in zipped format. 

 c PDF. The report is displayed in .pdf format in a new browser window.

• Select Zipped attachment to send the attachment in zipped format. 
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Note: If you choose to use a mail option that displays the report content in 
the e-mail client, check that the e-mail client does not employ security 
restrictions which prevent the running of scripts contained in HTML mail. 
E-mail clients that do employ such restrictions may be unable to properly 
display all report content.

 7 Click OK to e-mail the report.

Publishing a Report

You can generate up-to-date reports that can be viewed by users who do not 
usually work with Mercury Business Availability Center, and, therefore, do 
not know how to create reports. However, these users must have a network 
connection to Mercury Business Availability Center to view the report. You 
publish the reports in .csv format, .xml format, or printer-friendly format, 
and send the report (generally, by e-mail) to the user. 

The report contains data that is updated when the report is accessed. For 
example, say you prepare a report for the past month (24 Oct 2005 8:00 AM 
– 21 Nov 2005 8:00 AM), publish the report, and send the URL or an HTML 
file of the report to a user. The user accesses the report a week later (on 28 
Nov 2005), at which time the report shows the updated past month 
(31 Oct 2005 8:00 AM – 28 Nov 2005 8:00 AM). 

You would probably publish reports that use a relative tracking period (for 
example, past month, month to date), as it may not be useful to publish 
reports that use an absolute tracking period (for example, hour, day, 
month). You choose the time period in the View field: 
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You can choose between two methods for publishing reports: URL and 
HTML. Use URL to submit the form with a GET method (recommended), 
and HTML to submit the form with a POST method.

For a list of reports that you can publish, see the list of customizable reports 
in “Configuring a Report Header and Footer” in Platform Administration. You 
can also view a list of these reports in the Report Types window accessed 
from the Report Repository page. For details, see “Searching for a Report in 
the Report Repository” on page 125.

To publish a report in .csv, .xml, or printer-friendly format:

 1 Set up the report that you want to publish. Where relevant, choose the 
Graph or Table format. 

Tip: Choose only from tracking periods that will show data when the user 
accesses the report. For example, say you set up the Triage report to show 
data for the past hour, then send the report to a user. If the monitor being 
tracked by the profile is going down shortly, the user’s past hour will not 
include data.

 2 Click the Publish Report button to open the Publish Report window. 

 3 Choose the format in which you want to publish the report: CSV, XML, or 
Printer-Friendly. 

CSV. The report is formatted as a comma-separated values (CSV) text file 
that can be displayed in a spreadsheet.

XML. The report is formatted as an XML file that can be opened in a text or 
XML editor.

Printer-Friendly. The report is saved in HTML format to make it easy to 
print.

 4 Enter a login name and password which enable the user to log in to Mercury 
Business Availability Center, view the report, and log out. 



Part I • Working With Reports

28

Important: 

➤ The default login name and password are those with which you logged in 
to Mercury Business Availability Center in the current session. 

➤ Do not publish the report with administrator permissions. We 
recommend that you create a login name and password for the user with 
lower permissions than for an administrator. For details, see “User and 
User Group Management” in Platform Administration. 

➤ If you include your own user name and password in the URL or the 
HTML file, when the user closes the report, you are simultaneously 
logged out of Mercury Business Availability Center. 

➤ The user name and password are encrypted in the URL or the HTML file.

➤ The log in and log out steps are transparent to the user.

 5 Choose whether to send the URL of the report (recommended) or to send 
the report as an HTML file. Click Generate URL or Generate HTML: 

Generate URL. Mercury Business Availability Center generates the URL and 
displays it in the window. Click Copy to select the URL, then paste the URL 
into an e-mail to send to the user. It is recommended that the URL does not 
exceed a maximum length of 2,000 characters (~2K), to ensure that the URL 
can be read by all systems. 

Caution: Do not modify the URL string. If necessary, make changes to the 
report itself, then publish the report again.

Generate HTML. The File Download window opens and you can choose to 
open or save the file. Click Open to open the report in a browser in the 
selected format. Click Save, and, in the Save As dialog box that opens, locate 
the directory where you want to save the file, and click Save.
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Tip: To extract HTML code from the published report, choose the XML 
format and click Generate URL or Generate HTML. Continue with the 
relevant procedure to publish the report. Click Open to display the report in 
HTML markup in a browser. Save the file as HTML, open the file in an HTML 
editor, and copy the relevant table into the target file. 

Saving a Report to the Report Repository

You can save the data of certain reports to a report repository, for viewing on 
other occasions, or for sending to other users. The report is saved with data 
valid at the time the report is saved. This is the case even if data 
subsequently changes, or more data accrues to the report. You access the 
report through Dashboard, Service Level Management, or End User 
Management (Triage report only). 

For a list of reports that you can save to the repository, see the list of 
customizable reports in “Configuring a Report Header and Footer” in 
Platform Administration. You can also view a list of these reports in the 
Report Types window accessed from the Report Repository page. For details, 
see “Searching for a Report in the Report Repository” on page 125.

Note: The Report Repository icon appears only on the pages of reports that 
can be saved to the repository.

To save a report to the repository:

 1 Click the Save to Repository button to open a window displaying the report 
in PDF format.

 2 Enter a name for the report.  
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 3 Choose whether the report should be available to all users (Public), or only 
to yourself and the administrators (Private).

Public: any user can view, edit, or delete the report from the repository. 
Private: only the user or administrator can view, edit, or delete the report 
from the repository. (For Mercury Managed Services customers: Private: only 
the user, superuser, operator, customer superuser, and customer 
administrator can view, edit, or delete the report from the repository.) 

 4 Enter a description for the report.

 5 Click OK, or click Cancel to close the window without saving the report.

The report is displayed in the application page.
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3
Introducing User Reports

This chapter introduces user reports, which enable you to track the specific 
performance issues that are relevant to your organization or business unit’s 
performance monitoring needs.

This chapter describes: On page:

About User Reports 34

Creating User Reports 35

Viewing User Reports 36

Permissions in User Reports 37

Usage Tips 38
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About User Reports

Mercury Business Availability Center enables you to create and save user 
reports—customized reports containing user-defined data and formatting 
that can help you focus on specific aspects of your organization’s 
application and infrastructure resource performance. For an overview of 
creating user reports, see “Creating User Reports” on page 35.

Once saved, the reports are available for viewing by all system users with 
appropriate permissions. For an overview of viewing user reports, see 
“Viewing User Reports” on page 36.

You configure and view user reports from the User Reports tab, accessed 
from the Service Level Management, End User Management, and System 
Availability Management applications. For an overview of permissions 
required to create and view user reports, see “Permissions in User Reports” 
on page 37.

For tips on working with user reports, see “Usage Tips” on page 38.

For details on working with reports (choosing the time range, selecting the 
profile, saving and sharing reports, and so forth), see Chapter 1, “Working 
in Reports.”
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Creating User Reports

You can create user reports using the following tools, available from the User 
Reports tab:

➤ Custom Report Manager. Enables creating custom reports, which are made 
up of components that you select and define. Components are specific 
reports from the various Mercury Business Availability Center applications. 
You select the components that enable you to focus on the data you are 
most interested in tracking. For details, see Chapter 4, “Custom Report 
Manager.”

➤ Trend Report Manager. Enables creating trend reports, which are made up 
of different measurements that you select and define, collected by Mercury 
Business Availability Center or third-party data collectors. Trend reports 
enable you to compare multiple measurements from several sources on the 
same graph. For details, see Chapter 6, “Trend Report Manager.”

➤ Custom Link Manager. Enables creating custom link reports, which enable 
you to define a URL that is called via Mercury Business Availability Center 
and whose returned results are displayed in the browser, within the Mercury 
Business Availability Center interface. For details, see Chapter 7, “Custom 
Link Manager.”

➤ Excel Reports. Enable utilization of Microsoft Excel’s charting abilities to 
display various types of data collected by Mercury Business Availability 
Center data collectors. The data is extracted from the database using the 
Mercury Business Availability Center Open API. For details, see Chapter 8, 
“Integrating Microsoft Excel Reports in Mercury Business Availability 
Center.”

➤ OpenAPI Query Builder. Enables building queries that extract data from the 
profile databases for use in Excel reports and/or third-party or custom 
reporting tools. For details, see “The OpenAPI Query Builder” in Integrating 
with Third-Party Applications.

Once defined, user reports can be further tailored with custom headers and 
footers. For details, see Chapter 9, “Default Header/Footer.”
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Viewing User Reports

You view user reports from the following contexts, accessed from the User 
Reports tab in Service Level Management, End User Management, and 
System Availability Management:

➤ Reports List page. Displays all the defined custom reports, trend reports, 
and custom links that have been defined in the system, that the current user 
has permissions to view. The name of the owner of each report (that is, the 
user that created the report) is also displayed. 

From the Custom Reports and Trend Reports tables, you can generate, edit 
(if permissions for such are granted), and schedule reports. 

From the Custom Links table, you can display a Web page in the same 
browser window. 

For details on using the Reports List page, see Chapter 10, “Report Lists.”

➤ Excel Reports page. Displays links to Excel reports that have been uploaded 
to Mercury Business Availability Center. You view Excel reports in Microsoft 
Excel or any spreadsheet program capable of reading files of .xls format.

For details on creating Excel reports, see Chapter 8, “Integrating Microsoft 
Excel Reports in Mercury Business Availability Center.”

➤ Report Repository page. Displays reports saved to the report repository. You 
can search for and view reports that have been saved in the report 
repository. You can view saved reports in Dashboard, Service Level 
Management, and End User Management. For details, see Chapter 11, 
“Report Repository.”
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Permissions in User Reports

The following permission guidelines apply to creating and viewing user 
reports:

➤ All users have permissions to create custom reports, trend reports, and 
custom links for themselves.

➤ The Open Query component in custom reports can only be edited by users 
with Administrator or Superuser permissions (in Mercury Managed Services, 
Customer Administrator or Customer Superuser permissions).

➤ For users other than the report creator to view custom reports, trend reports, 
and custom links on the Reports List page (or have other permissions on the 
reports), such permissions must be granted by an administrator. Permissions 
can be granted on the report level.

➤ Permissions must be granted for viewing, adding, editing, or deleting Excel 
reports on the Excel Reports list. Permissions can only be granted on the list 
level.

➤ To access the OpenAPI Query Builder page, a user must have Administrator 
or Superuser permissions. The OpenAPI Query Builder page is not available 
to Mercury Managed Services customers.

➤ Permissions must be granted for defining a default header/footer. 

➤ Permissions to view a report saved to the report repository depend on 
whether, while saving the report to the repository, the user selected the 
Public or Private flag. Reports flagged as public can be viewed by all users. 
Reports flagged as private can be viewed by the user who saved the report to 
the repository and by users with Superuser permissions. 

(For Mercury Managed Services customers: Private: only the user, superuser, 
operator, customer superuser, and customer administrator can view, edit, or 
delete the report from the repository.) 
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Usage Tips

➤ When naming entities in user reports, follow the guidelines for allowed 
names. For details, see “Allowed Names in Mercury Business Availability 
Center” in Reference Information.

➤ You can instruct Mercury Business Availability Center to e-mail, on a 
periodic basis, certain types of user reports to recipients defined in Mercury 
Business Availability Center. For details, see “Scheduled Reports” in Platform 
Administration.

➤ After creating custom or trend reports, if you then configure user- or global-
level report filters to filter specific transactions, locations, or groups from 
reports, the filtered values still appear in the reports. To remove any newly 
filtered values from existing custom or trend reports, you must remove and 
re-add the components containing the elements for which filters have been 
set, and save the report.
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4
Custom Report Manager

This chapter explains how to create custom reports that include 
components—individual application reports that enable you to focus on the 
data you are most interested in tracking. 

This chapter describes: On page:

Overview of Custom Reports 40

Workflow for Creating Custom Reports 41

Defining Custom Report Properties 41

Adding a Component to a Report 43

Filtering Report Components 76

Defining a Header and Footer for a Custom Report 77

Modifying a Custom Report 79
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Overview of Custom Reports

The Custom Report Manager is accessed from the User Reports tab in the 
Service Level Management, End User Management, or System Availability 
Management applications.

Each custom report can consist of components from different Mercury 
Business Availability Center applications. You select components from the 
relevant applications. You then configure settings for each component, 
including format (chart or table), layout, and time settings. You also specify 
active filters, which enable you to design the report to focus on the specific 
information that you most want to track (for example, business-critical 
transactions or critical alerts). In addition, you can add a custom header and 
footer to the report.

You generate custom reports from the Custom Reports table on the Reports 
List page, accessed from the User Reports tab in the Service Level 
Management, End User Management, or System Availability Management 
applications. Reports are listed in alphabetical order.

Limitations

Within any one specific component, Mercury Business Availability Center 
can display only those profiles that have the same settings for outlier values. 
In the Custom Report Manager, you should select a set of profiles that have 
the same setting for outlier values. For details on modifying outlier value 
settings for a profile, see “Transaction Threshold Settings” in End User 
Management Data Collector Configuration.
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Workflow for Creating Custom Reports

Use the following workflow to create a custom report:

 1 Create the custom report and give it a name. For details, see “Defining 
Custom Report Properties” on page 41.

 2 Choose the application components to add to the report. For details, see 
“Adding a Component to a Report” on page 43.

 3 Filter a report component to display specific objects only. This step is 
optional. For details, see “Filtering Report Components” on page 76.

 4 Add a header and footer to the report. This step is optional. For details, see 
“Defining a Header and Footer for a Custom Report” on page 77.

 5 Save the report. 

 6 View the report in the Reports List. For details, see Chapter 10, “Report 
Lists.”

Defining Custom Report Properties

To define a custom report, you specify report properties.

To specify custom report properties:

 1 From the User Reports tab in Applications > Service Level Management, End 
User Management, or System Availability Management, select Custom 
Report Manager.

 2 In the Custom Report Manager, click New to open the Custom Report 
Properties window.

 3 In the Report title box, enter a descriptive name for the report.

 4 Click the Report name box. To specify a name that is different from the 
report title, replace the default name. This is the name that will appear in 
the Custom Reports section, on the Reports List page.
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 5 In the Time Period section, select a time period for the report. Choose one of 
the following options:

➤ Use global settings for all components. All components of the report use 
the same time period.

➤ Enable time period per component. Mercury Business Availability Center 
displays each component according to a different time period (which you 
define later).

Note: Time period is irrelevant for Service Level Management as custom 
reports are always calculated per component. 

 6 In the Report Auto-Refresh Settings section, select a refresh rate for the 
report, or specify that the page should not refresh automatically.

 7 Select Insert a page break after each component when printing the report 
to print a report in which each component’s information starts on a new 
page.

Note: This feature is available when running on Microsoft Internet Explorer 
only.

 8 Click OK to register the custom report properties. The custom report 
properties are not saved until after you add at least one component and 
click Save.

The next stage in the procedure is to add a component to the report. 
Continue to the next section.
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Adding a Component to a Report

The procedure for adding a component differs depending on the 
component type.

This section explains how to add a component, and includes the following 
topics:

➤ “Reports Component” on page 43

➤ “Real User Monitor Component” on page 46

➤ “Real User Events Component” on page 49

➤ “Service Level Management Component” on page 50

➤ “Dashboard Component” on page 52

➤ “URL Component” on page 53

➤ “Desktop Performance Component” on page 55

➤ “Open Query Component” on page 57

➤ “Triage Report Component” on page 70

➤ “SiteScope Monitor Performance Component” on page 71

➤ “SiteScope Cross-Performance Component” on page 73

Reports Component

Adds the Reports component to the custom report you are creating.

To add a Reports component:

 1 Select Reports from the Component type list.

 2 Click Add Component to open the Add Component dialog box.
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 3 From the Category list, select a report category.  

Category Available Reports

Performance Update 
Reports

(available for Business 
Process and Client 
Monitor profiles)

Performance of Transactions

Transaction Availability

Performance Update Summary

Performance of Locations

For details, see “The Performance Update Report” in 
Platform Administration.

User Experience 
Reports

(available for Business 
Process and Client 
Monitor profiles)

“Response Time over Time Report” in Using End User 
Management

“Response Time by Percentile Report” on page 71

“Breakdown over Time Report” in Using End User 
Management

“Performance Matrix Report” in Using End User 
Management

Overall Performance of 3 Worst Locations (multi-
profile). For details, see “Performance of Locations” in 
Using End User Management

“Profile Summary Report” on page 82

“Response Time – 90th Percentile Report” on page 83

Overall Performance by Profiles. For details, see “Multi-
Profile Summary Report” in Using End User Management.

“Availability over Time Report” in Using End User 
Management

“Breakdown Summary Report” in Using End User 
Management

“Min./Max. Response Time Report” in Using End User 
Management

Overall Performance of 3 Worst Profiles (multi-profile). 
For details, see “Multi-Profile Summary Report” in Using 
End User Management
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 4 From the Type list, select a report that you want to appear in the custom 
report. The available reports differ, depending on the selected category.

 5 From the View as list, select Graph or Table, depending on the format in 
which you want Mercury Business Availability Center to display the report. 
These options are not available for all reports.

 6 From the Profile list, select the profile on which you want the custom report 
data to be based. For certain reports you can select multiple profiles.

Mercury Business Availability Center displays different types of profiles 
(Business Process, Client Monitor, SiteScope), depending on the report 
category you select.

 7 In the Title box, type the descriptive title that you want to appear above the 
component in the custom report, or accept the default name. 

It is recommended that you use a title that describes the specific elements 
upon which the component will focus (for example, a particular transaction 
from a particular location).

Alert Reports

(available for all 
profiles)

“Alert Log” in Using End User Management

“Alert Count over Time Report” in Using End User 
Management

“Alert Count by Severity Report” in Using End User 
Management

SiteScope Reports

(available for SiteScope 
profiles)

“SiteScope Data over Time” in Using System Availability 
Management

SiteScope Profile Summary. For details, see “Group 
Performance Report” in Using System Availability 
Management

“Overall Performance Report” in Using System 
Availability Management

Category Available Reports
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 8 If you selected Enable time period per component when defining the report 
properties, select the default time period for which Mercury Business 
Availability Center initially generates the report in the Interval list. For 
details, see “Defining Custom Report Properties” on page 41.

In the Start list, select a starting time for the component.

 9 In the Size section, select the size for the component. Select Wide to display 
the report across the whole page. Select Narrow to display the report across 
half the page.

 10 In the Position list, select the position for the component within the custom 
report, relative to the other components. Selecting 1 instructs Mercury 
Business Availability Center to place the component at the top (for the first 
component, you must select 1).

For a component to appear in the Narrow format, you must have two 
Narrow components positioned consecutively.

 11 Click OK to save the component settings.

 12 Repeat steps 1-11 for each Reports component you want to add to the 
report.

 13 To save the custom report, click Save.

The next stage in the procedure is to add another component (“Adding a 
Component to a Report” on page 43) or to filter report components 
(“Filtering Report Components” on page 76).

Real User Monitor Component

Adds the Real User Monitor component to the custom report you are 
creating.

To add a Real User Monitor component:

 1 Select Real User Monitor from the Component type list.

 2 Click Add Component to open the Add Component dialog box.
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 3 From the Report list, select a report.

 4 In the Title box, type the descriptive title that you want to appear above the 
component in the custom report, or accept the default name. 

It is recommended that you use a title that describes the specific elements 
upon which the component will focus (for example, a particular transaction 
from a particular location).

 5 When one of the selected reports is one of the global statistics reports: Most 
Popular Pages, Most Active End Users, Slowest End Users, Slowest Pages, or 
Broken Links, you must select one engine from the defined End User 
Management engines in the Engine list.

Category Available Reports

Page Summary “Page Summary Report” in Using End User 
Management

End User Summary “End User Summary Report” in Using End User 
Management

Transaction Summary “Transaction Summary Report” in Using End User 
Management

Server Summary “Server Summary Report” in Using End User 
Management

Most Popular Pages “Global Statistics Report” in Using End User 
Management

Most Active End Users

Slowest End Users

Pages with Slowest Server 
Time

Broken Links
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 6 In the Tab list, select the tab that you want to appear in the custom report. 
The available reports differ, depending on the selected category:

 7 From the Sorting Column list, select the column by which to sort the report. 
The default is the first column. The Sorting Column list includes all the table 
columns.

In some cases, in the displayed report, you may select a tab where the 
sorting column does not appear. Nevertheless, the displayed report is still 
sorted by that column.

 8 Select the Ascending or Descending direction in the Sorting Direction radio 
buttons.

 9 In the Number of Rows list, select the number of rows to display in the 
report. 

 10 In the Start list, select a starting time for the component.

 11 In the Position list, select the position for the component within the custom 
report, relative to the other components. Selecting 1 instructs Mercury 
Business Availability Center to place the component at the top of the page 
(for the first component, there is no choice).

 12 Click OK to save the component settings.

 13 If necessary, click the Component Filter button to specify the component 
active filters. For details, see “Using the Real User Monitor Active Filters” in 
Using End User Management.

Category Available Tab

Pages ➤ General (default)

➤ Availability

➤ Performance

➤ Server Performance

Transactions ➤ General (default)

➤ Availability

➤ Total Performance

➤ Net Performance

➤ Server Performance
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 14 To save the custom report, click Save.

The next stage in the procedure is to add another component (“Adding a 
Component to a Report” on page 43) or to filter report components 
(“Filtering Report Components” on page 76).

Real User Events Component

Adds the Real User Events component to the custom report you are creating.

Note: To see data in the report, after adding Real User Events report 
components, you must select CIs and KPIs in the filter. 

To add a Real User Events component:

 1 Select Real User Events from the Component type list.

 2 Click Add Component to open the Add Component dialog box.

 3 From the Report list, select a report.

 4 In the Title box, type the descriptive title to appear above the component in 
the custom report, or accept the default name. 

Tip: It is recommended that you use a title that describes the specific 
elements upon which the component will focus (for example, a particular 
transaction from a particular location).

Category Available Reports

Event Count over Time “Event Count Over Time Report” in Using End User 
Management

Event Summary “Event Summary Report” in Using End User 
Management
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 5 If you selected Enable time period per component when defining the report 
properties, select the default start time from which Mercury Business 
Availability Center initially calculates the report. For details, see “Defining 
Custom Report Properties” on page 41.

 6 Select the required Size option:

➤ Wide to display the report across the whole page

➤ Narrow to display the report across half the page.

 7 From the Position list, select the position for the component within the 
custom report, relative to the other components. Selecting 1 instructs 
Mercury Business Availability Center to place the component at the top (for 
the first component, there is no choice).

For a component to appear in the Narrow format, you must have two 
Narrow components positioned consecutively.

 8 Click OK to save the component settings.

The next stage in the procedure is to add another component (“Adding a 
Component to a Report” on page 43) or to filter report components 
(“Filtering Report Components” on page 76).

Service Level Management Component

Adds the Service Level Management component to the custom report you 
are creating. For details on Service Level Management reports, see 
“Introduction to Service Level Management Reports” in Using Service Level 
Management.

Note: To see data in the report, after adding Service Level Management 
Report components, you must select the time period and the filter items. 

To add a Service Level Management report component:

 1 Select Service Level Management from the Component type list.

 2 Click Add Component to open the Add Component dialog box.
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 3 From the Report list, select the specific report that you want to appear in the 
custom report.

 4 In the Title box, type the descriptive title that you want to appear above the 
component in the custom report, or accept the default name.

 5 From the View as list, select Graph or Table, depending on the format in 
which you want Mercury Business Availability Center to display the report. 
These options are not available for all reports.

 6 To determine how the report is displayed, choose between Wide and 
Narrow.

For a component to appear in the Narrow format, you must have two 
Narrow components positioned consecutively.

Category Available Reports

CI Impact “CI Impact Report” in Using Service Level Management

CIs Over Time vs. Target “CI Over Time vs. Target Report” in Using Service Level 
Management

CI Status “CI Status Report” in Using Service Level Management

CI Summary “CI Summary Report” in Using Service Level 
Management

CIs Over Time “CIs Over Time Report” in Using Service Level 
Management

Outage Breakdown “Outage Breakdown Report” in Using Service Level 
Management

Outage Distribution “Outage Distribution Report” in Using Service Level 
Management

Outages Summary “Outage Summary Report” in Using Service Level 
Management

SLA Status Alert “SLA Status Alerts” in Using Service Level Management

SLAs Summary “SLAs Summary Report” in Using Service Level 
Management

Time Range Comparison “Time Range Comparison Report” in Using Service 
Level Management
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 7 From the Position list, select the position for the component within the 
custom report, relative to the other components. Selecting 1 instructs 
Mercury Business Availability Center to place the component at the top (for 
the first component, there is no choice).

 8 Click OK to save the component settings.

 9 Repeat steps 1-8 for each component you want to add to the report.

 10 To save the custom report, click Save.

The next stage in the procedure is to add another component (“Adding a 
Component to a Report” on page 43) or to filter report components 
(“Filtering Report Components” on page 76).

Dashboard Component

Adds the Dashboard component to the custom report you are creating. 

Note: To see data in the report, after adding Dashboard components, you 
must select CIs and KPIs in the filter. 

To add a Dashboard component:

 1 Select Dashboard from the Component type list.

 2 Click Add Component to open the Add Component dialog box.

 3 From the Report list, select a report.

Category Available Reports

Configuration Item 
Status Alerts

“Configuration Item Status Alerts Report” in Using 
Dashboard

KPIs over Time “KPIs Over Time Reports” in Using Dashboard 

Raw Data Over Time “Raw Data Over Time Reports” in Using Dashboard 
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 4 In the Title box, type the descriptive title that you want to appear above the 
component in the custom report, or accept the default name. 

It is recommended that you use a title that describes the specific elements 
upon which the component will focus (for example, a particular transaction 
from a particular location).

 5 If you selected Enable time period per component when defining the report 
properties, select the default start time from which Mercury Business 
Availability Center initially calculates the report. For details, see “Defining 
Custom Report Properties” on page 41.

 6 Select the required Size option:

➤ Wide to display the report across the whole page

➤ Narrow to display the report across half the page.

 7 In the Position list, select the position for the component within the custom 
report, relative to the other components. Selecting 1 instructs Mercury 
Business Availability Center to place the component at the top (for the first 
component, you must select 1).

 8 Click OK to save the component settings.

The next stage in the procedure is to add another component (“Adding a 
Component to a Report” on page 43) or to filter report components 
(“Filtering Report Components” on page 76).

URL Component

Select the URL component to create a report that calls a specified URL. For 
example, you can integrate links to external charts generated by third-party 
EMS software into the custom report. You specify the URL as well as any 
parameters that you want the URL to process at runtime.

Mercury Business Availability Center provides two templates that you can 
use as the arguments for parameters that process report times:

➤ Start time. Uses the argument $$startTime$$ to return the start time for 
the report.

➤ End time. Uses the argument $$endTime$$ to return the end time for the 
report.
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The following example shows a URL that uses parameters to return the chart 
type and start time of a report:

Note: If the specified Web page includes JavaScript code that attempts to 
access the top frame, the browser will display an “access denied” error. To 
avoid this issue, set the browser to ignore JavaScript errors.

To add a URL component:

 1 Select URL from the Component type list.

 2 Click Add Component to open the Add Component dialog box.

 3 In the Title box, type the descriptive title that you want to appear above the 
component in the custom report. 

 4 In the URL box, type the URL of the Web page you want Mercury Business 
Availability Center to display in the report. If the URL includes parameters, 
specify them as required.

 5 To use one of the predefined arguments with a parameter in the URL, place 
the insertion point in the URL where you want to add the argument, select 
the required argument from the URL runtime templates list, and click Add 
Template.

 6 If you selected Enable time period per component when defining the report 
properties, select the default time period for which Mercury Business 
Availability Center initially generates the report in the Interval list. For 
details, see “Defining Custom Report Properties” on page 41.

In the Start list, select a starting time for the component.

 7 In the Width and Height boxes, select the frame size for the component. 
When doing so, keep in mind the required frame size for correctly viewing 
the Web page content being accessed.

http://www.myapp.com?graph=responsetime;starttime=$$startTime$$
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 8 In the Size section, select the size for the component. Select Wide to display 
the report across the whole page. Select Narrow to display the report across 
half the page.

When selecting the component size, keep in mind the frame size you 
specified in step 7.

 9 From the Position list, select the position for the component within the 
custom report, relative to the other components. Selecting 1 instructs 
Mercury Business Availability Center to place the component at the top (for 
the first component, there is no choice).

For a component to appear in the Narrow format, you must have two 
Narrow components positioned consecutively.

 10 Click OK to save the component settings.

 11 Repeat steps 1-10 for each URL component you want to add to the report.

 12 To save the custom report, click Save.

The next stage in the procedure is to add another component (“Adding a 
Component to a Report” on page 43) or to filter report components 
(“Filtering Report Components” on page 76).

Desktop Performance Component

Select the Desktop Performance component to add the Desktop 
Performance report to the custom report you are creating. The Desktop 
Performance report enables you to view the least available, worst 
performing, or least active desktops for which the Client Monitor has 
collected data. A desktop is the end-user’s machine on which Client Monitor 
runs.

For details on the Desktop Performance report, see “Desktop Performance 
Report” in Using End User Management.

To add a Desktop Performance component:

 1 Select Desktop Performance from the Component type list.

 2 Click Add Component to open the Add Component dialog box.

 3 From the Profile list, select the Client Monitor profile on which you want 
the custom report data to be based.
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 4 In the Title box, type the descriptive title that you want to appear above the 
component in the custom report, or accept the default name. 

 5 If you selected Enable time period per component when defining the report 
properties, from the Interval list, select the default time period for which 
Mercury Business Availability Center initially generates the report. For 
details, see “Defining Custom Report Properties” on page 41.

In the Start list, select a starting time for the component.

 6 In the Size section, select the size for the component. Select Wide to display 
the report across the whole page. Select Narrow to display the report across 
half the page.

 7 From the Position list, select the position for the component within the 
custom report, relative to the other components. Selecting 1 instructs 
Mercury Business Availability Center to place the component at the top (for 
the first component, there is no choice).

For a component to appear in the Narrow format, you must have two 
Narrow components positioned consecutively.

 8 Select the type of data you want the report to display. Choose from:

➤ least/most available desktops (transaction success)

The list is sorted by availability.

➤ worst/best-performing desktops (transaction response time)

The list is sorted by response time.

➤ least/most active desktops (number of transactions)

The list is sorted according to the number of transactions that ran during 
the specified time period.

 9 Click OK to save the component settings.

 10 Repeat steps 1-9 for each Desktop Performance component you want to add 
to the report.

 11 To save the custom report, click Save.

The next stage in the procedure is to add another component (“Adding a 
Component to a Report” on page 43) or to filter report components 
(“Filtering Report Components” on page 76).
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Open Query Component

Select the Open Query component to build a Generic Data Engine API query 
that returns a tabular or graphical representation of the data retrieved from 
the database. The Open Query component user interface is similar to that of 
the OpenAPI Query Builder. For details on the OpenAPI Query Builder and 
on the Generic Data Engine API in general, see “Working with Data APIs” in 
Integrating with Third-Party Applications.

To add an Open Query component:

 1 Select Open Query from the Component type list.

 2 Click Add Component to open the Add Component dialog box.

 3 In the Title box, type the descriptive title to appear above the component in 
the custom report, or accept the default name. 

 4 If you selected Enable time period per component when defining the report 
properties, select the default start time from which Mercury Business 
Availability Center initially calculates the report. For details, see “Defining 
Custom Report Properties” on page 41.

 5 In the Size section, select the size for the component. Select Wide to display 
the report across the whole page. Select Narrow to display the report across 
half the page.

 6 From the Position list, select the position for the component within the 
custom report, relative to the other components. Selecting 1 instructs 
Mercury Business Availability Center to place the component at the top (for 
the first component, there is no choice).

For a component to appear in the Narrow format, you must have two 
Narrow components positioned consecutively.

 7 Click OK to save the component settings.

To define the Open Query call to the database:

 1 Click the Component Filter button to define the query parameters using the 
OpenAPI Query Builder interface. For detailed information on creating 
Generic Data Engine API queries with the OpenAPI Query Builder interface, 
including query limitations, see “The OpenAPI Query Builder” in Integrating 
with Third-Party Applications.
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 a From the Sample type list, select a data sample type. For a description of 
the available sample types, see “Samples” in Reference Information.

 b To group returned data according to a specific granularity setting, which 
you select when generating the report, (for example, if you want data for 
the past day grouped per hour), select Return data per specified 
granularity.

Note: If you modify this setting after configuring presentation settings, 
the presentation settings will be lost. For details on presentation settings, 
see “Configuring Presentation Settings” on page 67.

Tip: If you select Return data per specified granularity, it is 
recommended not to select the time_stamp field in your query. This is 
because, if Return data per specified granularity is selected, Mercury 
Business Availability Center automatically adds a time dimension to the 
report.

 c Select the data fields of the chosen sample type that you want to extract 
from the database and the operations to perform on the data. For details 
on selecting data fields and operations, see “Creating Queries Using the 
OpenAPI Query Builder” in Integrating with Third-Party Applications. For 
detailed descriptions of the available data fields per sample type, see 
“Samples” in Reference Information.

 d If required, modify the field alias or field formula. For details, see 
“Creating Queries Using the OpenAPI Query Builder” in Integrating with 
Third-Party Applications.

Tip: To display returned response time in seconds rather than milliseconds, 
edit the field formula for Response Time, dResponseTime, as follows: 
dResponseTime/1000. This can be done for any value displayed by default in 
milliseconds, for example, thresholds.

 e If required, modify the field properties. For details, see “Modifying Field 
Properties” on page 59.
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 f Apply filters to the extracted data. For details on applying filters, see 
“Creating Queries Using the OpenAPI Query Builder” in Integrating with 
Third-Party Applications. For a list of query limitations, see “Query 
Limitations” in Integrating with Third-Party Applications.

 g Configure presentation settings to instruct Mercury Business Availability 
Center how to present the data in the custom report. For details, see 
“Configuring Presentation Settings” on page 67. If you do not configure 
presentation settings, the data is returned in standard table format. The 
order of the columns in the standard table is determined by the order of 
the fields in the Fields to Return list.

 2 Click OK to save the settings.

 3 Click Save to save the report.

Modifying Field Properties

Each field has default properties defined by the field metadata. The Field 
Properties dialog box enables you to modify the default field properties and 
define custom properties for the field.

To modify field properties:

 1 Click the Field Properties button beside the field whose properties you want 
to edit. The Field Properties dialog box opens.

 2 Modify the properties as required. For details on the properties that can be 
modified, see “Field Properties” on page 59.

 3 To revert all properties to their default settings, click Reset.

 4 Click OK to save the settings.

Field Properties

You can modify the following field properties:

➤ Type. The default type for the field is initially displayed. This can be 
modified if required. 
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Examples: By changing a field type from Double to Integer, you can display 
the returned data without the decimal point; if you use a function to modify 
a field formula in a way that results in a numerical value becoming a string 
(for example if you change (dResponseTime) to 
IF(dResponseTime,>,5000,pass,fail), you must change the type to String to 
enable the returned result to display correctly in a table).

The following field types exist:

➤ String. Used for textual expressions.

➤ Date. Used for date fields.

➤ Double. Used for numerical fields.

➤ Integer. Used for numerical fields.

➤ Max. Length. Displayed only for String field type. Used to set a maximum 
length, in characters, for the displayed string. In cases where the string 
exceeds the defined length, a tooltip is shown with the complete string.

➤ Format. Displayed for Date, Double, and Integer field types. Used to 
customize the format of the displayed date or numerical data in data tables, 
as well as in graphs (x-axis, tooltips, legend). For a list of possible formats 
and syntax examples, see “Field Formats” on page 60.

➤ OK/Critical Threshold. Displayed for Double and Integer field types. Used to 
add color coding in tables and graphs to data for which thresholds in the 
system have been defined—for example, to display transaction response 
time data with color coding corresponding to the OK, Warning, and Critical 
thresholds defined in Monitor Administration. In tables, the color coding is 
in the form of colored cells. In graphs, the color coding is in the form of a 
colored line. For details on working with OK/Critical Threshold settings, see 
“OK/Critical Thresholds” on page 63.

Field Formats

You enter values in the Formats box to modify the default format for a field, 
as defined in the field’s metadata. For example, the default date format is 
M/dd/yy hh:mm:a, which displays the date_stamp data as 
5/22/06 11:25 AM. By changing the date format, you can modify the way 
the date_stamp data is displayed. 
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Another example is if you want to add a string beside the returned data such 
as the literal string “ms” after returned response time data. The allowed 
formats are based on Java formatting classes. 

Some typical date/time formats include:

Symbol Meaning Type Examples

y Year Number yy > 06

yyyy > 2006

M Month Text or Number M > 7

M > 12

MM > 07

MMM > Jul

MMMM > 
December

d Day in month Number d > 3

d > 14

dd > 03

h Hour (1-12, 
AM/PM)

Number h > 3

h > 11

hh > 03

H Hour (0-23) Number H > 15

HH > 15

m Minute Number m > 7

m > 15

mm > 15

s Second Number s > 15

ss > 15

S Millisecond (0-
999)

Number SSS > 007
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Some typical decimal formats include:

E Day in week Text EEE > Tue

EEEE" > Tuesday

a AM/PM Text a > AM

aa > AM

z Time zone Text z > EST

zzz > EST

zzzz > Eastern 
Standard Time

' Escape for text Delimiter 'hour' h > hour 9

Symbol Meaning Examples

0 Shows a digit or 0 if no digit 
present

Value: 123.78 

Pattern: 000000.000 

Output: 000123.780 

# Shows a digit or nothing if no 
digit present

Value: 123.78 

Pattern: #.###

Output: 123.78 

. Indicates the decimal point Value: 123.78 

Pattern: #.##

Output: 123.78

, Used to group numbers Value: 4123.78 

Pattern: ,###.##

Output: 4,123.78 

Symbol Meaning Type Examples
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A complete reference to these classes is located on the Sun Web site, at the 
following URLs: 

➤ Date and Time Patterns. 
http://java.sun.com/j2se/1.4.2/docs/api/java/text/SimpleDateFormat.html

➤ Decimal Format Patterns. 
http://java.sun.com/j2se/1.4.2/docs/api/java/text/DecimalFormat.html

OK/Critical Thresholds

You enter values in the OK Threshold and Critical Threshold boxes to add 
color coding to your reports. Colors are added to the reports as follows:

➤ Green. For values corresponding to the specified OK Threshold value.

➤ Red. For values corresponding to the specified Critical Threshold value.

➤ Yellow. For values in between the specified OK Threshold and Critical 
Threshold values.

' Used to quote a literal symbol Value: 123.78 

Pattern: '#'###.##

Output: #123.78

% Multiplies by 100 and shows as 
percentage

Value: 123.78 

Pattern: #%

Output: 12378%

Symbol Meaning Examples
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Example 1: Assuming your report is in table format, if you edit the field 
properties for transaction response time and specify 2000 ms for the OK 
Threshold and 4000 ms for the Critical threshold, all returned transaction 
response time values that are less than or equal to 2000 ms will be colored 
green, all returned transaction response time values that are greater than or 
equal to 4000 ms will be colored red, and all in-between values will be 
colored yellow. This will be the case even if, in Monitor Administration, 
thresholds are defined differently.



Chapter 4 • Custom Report Manager

65

Example 2: Assuming your report is in graph format and average response 
time is selected for the y-axis, if you edit the field properties for transaction 
response time and specify 2000 ms for the OK Threshold and 4000 ms for 
the Critical threshold, a green line is drawn on the graph at the 2000 point 
and a red line is drawn on the graph at the 4000 point.

Two types of values can be entered in the OK Threshold and Critical 
Threshold boxes:

➤ Numerical values. You enter the actual values according to which you want 
data colored. Numerical values entered in the OK/Critical Threshold boxes 
will color code both data tables (cells whose values are within a specific 
threshold range are colored accordingly) and graphs (a colored line 
representing the specified value is added to the graph). The values that you 
enter override any actual set threshold values. 
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Note: When editing the query presentation format to return a graph, if you 
configure multiple y-axes on the same graph, no colored line is displayed. 
For details on editing presentation see “Configuring Presentation Settings” 
on page 67.

➤ Referenced fields. You enter the exact field alias of two other fields that have 
been added to the query. The values of the referenced fields must be 
numerical. Typically you add threshold fields such as Green Threshold and 
Red Threshold. Referenced fields entered in the OK/Critical Threshold boxes 
will color code only data tables (cells whose values are within a specific 
threshold range are colored accordingly). Graphs will not be color coded.

The following logic is used when determining how to interpret the values 
placed in the OK Threshold and Critical Threshold boxes to correctly apply 
color to the reports:

➤ If the numerical value or value of the referenced field entered in the OK 
Threshold box is lower than the numerical value or value of the referenced 
field entered in the Critical Threshold box, Mercury Business Availability 
Center assumes that lower values are OK and higher values are Critical (for 
example, response time). Data is colored accordingly.

For example, under this assumption, values returned for the field whose 
properties you are editing that were less than or equal to the numerical 
value or value of the referenced field specified in the Green Threshold box 
would be colored green.

➤ If the numerical value or value of the referenced field entered in the OK 
Threshold box is higher than the numerical value or value of the referenced 
field entered in the Critical Threshold box, Mercury Business Availability 
Center assumes that higher values are OK and lower values are Critical (for 
example, measurement of disk space). Data is colored accordingly.

For example, under this assumption, values returned for the field whose 
properties you are editing that were less than or equal to the numerical 
value or value of the referenced field specified in the Red Threshold box 
would be colored red.
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Configuring Presentation Settings

You can configure whether the data returned by the query is displayed as a 
table or graph. You can further configure table type (regular or pivot) or 
graph type (bar or line).

Note: If you modify the Return data per specified granularity setting after 
configuring presentation settings, the presentation settings will be lost.

To configure presentation settings:

 1 Click the Edit Presentation button to open the Presentation Settings dialog 
box.

 2 On the Choose Presentation View page, select either Table or Graph and 
click Next.

If you selected Table, continue to step 3. If you selected Graph, jump to 
step 7.

 3 On the Choose Table Type page, select Regular or Pivot and click Next.

➤ Regular. Displays a standard table with a column for each field in the 
query.

➤ Pivot. Displays a table that can include multiple fields in a spreadsheet 
type of matrix.

 4 If you select a regular table, follow the below steps. If you selected a pivot 
table, jump to step 5.

 a On the Select Field Order page, use the arrows to specify the order in the 
table (from left to right) that the columns appear. Click Next.

 b On the Sort Field Order page, use the left/right arrows to specify the fields 
by which you want to sort the table. Select one or more of the fields you 
move to the Sorted Fields box, and click the left-hand set of up/down 
arrows to specify an ascending or descending sort. Use the right-hand set 
of up/down arrows to specify the sort hierarchy (fields are first sorted by 
the topmost field, then by the next, and so forth.
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Data is sorted, by default, as follows:

• String. Ascending, alphabetically.

• Date. Ascending, oldest to newest.

• Double/Integer. Ascending, numerically.

 c Click OK to save the settings and close the Presentation Settings wizard.

 5 If you select a pivot table, follow the below steps on the Table Definition 
page.

Note: If Return data per specified granularity is selected for the query, 
Mercury Business Availability Center adds Time to the list of available fields 
in the pivot table definition page.

 a Select a field from the Across Column list. You can select only one field 
for the across column. Each unique value returned for that field will be 
displayed in a separate column in the table. Examples of useful fields to 
select for the across column include time, location, or any other field 
that returns a relatively small number of data points that are useful to 
compare one to another.

 b Select a field from the Value Field list. You can select only one value field. 
It is recommended that you select a field that returns a meaningful 
numerical value, for example response time. Do not select date-related 
fields such as Time or time_stamp. 

 c Select one or more fields from the Available Key Columns list and move 
them to the Selected Key Columns list. Each selected field will be 
displayed in the table, to the left of the field selected for the Across 
Column. Consider selecting fields for the key columns that contain data 
that you want to compare against the field selected in the across column. 
For example, in a query filtered to one specific transaction, if you 
selected time for the across column and average response time for the 
value column, you could select location and host fields as key columns; 
this would enable you to directly compare average response time of a 
transaction for various hosts at different locations at specific points in 
time.
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Note: The fields that remain in the Available Key Columns box still exist 
in the query, but are hidden in the report table returned by the query.

 d Use the up and down arrows below the Selected Key Columns list to 
specify the order in the table (from left to right) that the columns appear.

 6 Click OK to save the settings and close the Presentation Settings wizard.

 7 If you selected Graph, on the Choose Graph Type page, select Bar or Line 
and click Next.

 8 On the Define Graph page, specify graph settings as follows:

 a Select one or more numerical fields to display on the y-axis (only 
numerical fields are supported). Fields selected for the y-axis are removed 
from the Dimensions list.

• If multiple y-axis fields are selected but no dimensions are selected, 
one single graph is displayed with all the fields on the same y-axis. For 
the graph with multiple y-axis fields to be meaningful, consider 
selecting fields whose values are comparable.

• If multiple y-axis fields are selected and one or more dimensions are 
selected, a separate graph is displayed for each separate y-axis.

 b Select a field to display on the x-axis. Both numerical fields and strings 
are supported.

Note: If Return data per specified granularity is selected for the query, 
Mercury Business Availability Center defines the x-axis as Time. This 
cannot be modified.

 c Optionally, in the Min. Scale and Max. Scale boxes, specify both a 
minimum and maximum value for the y-axis scale.

 d Optionally, select one or more dimensions for the graph. The data for a 
field selected as a dimension is displayed on the graph separately, 
differentiated using a color coding. If no dimensions are selected, the 
y-axis value is used as the single dimension.

Note: The fields that remained in the Available Dimensions box are not 
sent as part of the query and do not appear in the report.
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For example, if you configure a graph with time along the x-axis and 
average response time along the y-axis, and select transaction name as a 
dimension, each returned transaction appears as one dimension of the 
graph, color coded as per the legend.

 9 Click Finish to save the settings and close the Presentation Settings wizard.

Triage Report Component

Adds the Triage Report component to the custom report you are creating. 

To add a Triage Report component:

 1 Select Triage Report from the Component type list.

 2 Click Add Component to open the Add Component dialog box.

 3 In the Title box, type the descriptive title to appear above the component in 
the custom report, or accept the default name. 

 4 The start time is defined in the report’s filter. For details, see “Filtering 
Report Components” on page 76.
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 5 In the Size section, select the size for the component. Select Wide to display 
the report across the whole page. Select Narrow to display the report across 
half the page.

 6 From the Position list, select the position for the component within the 
custom report, relative to the other components. Selecting 1 instructs 
Mercury Business Availability Center to place the component at the top (for 
the first component, there is no choice).

For a component to appear in the Narrow format, you must have two 
Narrow components positioned consecutively.

 7 To save the component settings, click OK.

 8 To save the custom report, click Save.

The next stage in the procedure is to add another component to the report 
(“Adding a Component to a Report” on page 43) or to filter report 
components (“Filtering Report Components” on page 76).

SiteScope Monitor Performance Component

Select the SiteScope Monitor Performance component to add the Monitor 
Performance report to the custom report you are creating. The Monitor 
Performance report enables you to view the best- or worst-performing 
SiteScope monitors across various SiteScope categories, such as monitor 
type, monitored server, or monitor title.

For details on the Monitor Performance report, see “Monitor Performance 
Report” in Using System Availability Management.

To add a SiteScope Monitor Performance component:

 1 Select SiteScope Monitor Performance from the Component type list.

 2 Click Add Component to open the Add Component dialog box.

 3 From the Profile list, select the SiteScope profile(s) on which you want the 
custom report data to be based.

 4 From the Monitor type list, select the monitor on which you want the 
custom report data to be based. To base the report on all monitors, choose 
All types.
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 5 In the Monitor title and Server name boxes, specify the monitors (by their 
title, as defined in SiteScope) and/or servers on which you want the custom 
report data to be based.

Leave a box empty to instruct Mercury Business Availability Center to base 
the report on all values.

You can use the asterisk symbol (*) as a wildcard to instruct Mercury 
Business Availability Center to base the report on a subset of all values. For 
example, to name all CPU monitors in SiteScope with the naming 
convention cpu_<servername>, specify cpu* to instruct Mercury Business 
Availability Center to include all CPU monitors in the custom report.

Note: It is not recommended to enter a wildcard as the first character in a 
string because Mercury Business Availability Center is unable to use the 
Index tables when querying the database, thus slowing report generation 
times.

 6 In the Display list, select whether you want Mercury Business Availability 
Center to display the best- or worst-performing monitors, and choose the 
number of monitors to be displayed in the report in the Monitors list.

 7 In the Title box, type the descriptive title to appear above the component in 
the custom report, or accept the default name. 

 8 If you selected Enable time period per component when defining the report 
properties, select the default time period for which Mercury Business 
Availability Center initially generates the report in the Interval list. For 
details, see “Defining Custom Report Properties” on page 41.

In the Start list, select a starting time for the component.

 9 In the Size section, select the size for the component. Select Wide to display 
the report across the whole page. Select Narrow to display the report across 
half the page.

 10 From the Position list, select the position for the component within the 
custom report, relative to the other components. Selecting 1 instructs 
Mercury Business Availability Center to place the component at the top (for 
the first component, there is no choice).
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For a component to appear in the Narrow format, you must have two 
Narrow components positioned consecutively.

 11 Click OK to save the component settings.

 12 Repeat steps 1-11 for each SiteScope Monitor Performance component you 
want to add to the report.

 13 To save the custom report, click Save.

The next stage in the procedure is to add another component (“Adding a 
Component to a Report” on page 43) or to filter report components 
(“Filtering Report Components” on page 76).

SiteScope Cross-Performance Component

Select the SiteScope Cross-Performance component to add the SiteScope 
Cross-Performance reports to the custom report that you are creating. The 
SiteScope Cross-Performance reports display the behavior of the same 
measurement in different monitored servers, or the behavior of different 
measurements from different types of monitor on the same monitored 
server.

They also display a summary table for each monitor type. The summary 
table displays the percentage of uptime, warning, and failure measurements 
out of the total number of measurements for each selected server. Each 
summary table includes a summary row that indicates the uptime, warning, 
and error percentage for all servers for that type of monitor. The report can 
be re-scaled to make it more relevant to what you are measuring.

For details on the Cross-Performance report, see “Cross-Performance Report” 
in Using System Availability Management.

To add a SiteScope Cross-Performance component:

 1 Select SiteScope Cross-Performance from the Component type list.

 2 Click Add Component to open the Add Component dialog box.
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 3 Choose whether to display the monitor type or title when selecting the 
component to add to the report:

➤ Monitor type. The type of monitor is displayed, for example, Ping, CPU.

➤ Monitor title. The name given to the specific monitor, for example, 
ping: myserver, CPU finance_server.

 4 From the Profile list, select the SiteScope profile(s) on which you want the 
custom report data to be based.

 5 From the Server list, select the SiteScope server(s) on which you want the 
custom report data to be based.

 6 Depending on whether you chose Filter by Monitor Type or Filter by 
Monitor, the Monitor Types/Monitor Titles list displays monitor types or 
monitor names, associated with the selected profiles and servers, in 
alphabetical order. Select one or more monitors. 

 7 From the Measurement list, select the measurement(s) on which you want 
the custom report data to be based.

Note: If a box is empty, you will not be able to generate the report.

Enter a string in one of the Contains boxes and click on the filter button , to 
list all the elements whose name includes the string.

 8 Select Consolidate data per measurement if you want the report to group 
data per measurement, for all the selected servers. If you clear Consolidate 
data per measurement, the report groups data per server. For details, see 
“Consolidated Over Time Graphs” and “Non-Consolidated Over Time 
Graphs” in Using System Availability Management.

 9 Select Show status summary tables if you want the report to display uptime, 
warning, and error summary tables.

 10 If required, enter scale information in the Scale Min and Max boxes. For 
details, see “Rescaling a SiteScope Cross-Performance Report” in Using System 
Availability Management.

 11 If you selected Enable time period per component when defining the report 
properties, select the default time period for which Mercury Business 
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Availability Center initially generates the report in the Interval list. For 
details, see “Defining Custom Report Properties” on page 41.

In the Start list, select a starting time for the component.

 12 In the Title box, type the descriptive title to appear above the component in 
the custom report. 

 13 In the Size section, select the size for the component. Select Wide to display 
the report across the whole page. Select Narrow to display the report across 
half the page.

 14 From the Position list, select the position for the component within the 
custom report, relative to the other components. Selecting 1 instructs 
Mercury Business Availability Center to place the component at the top (this 
is the default for the first component).

For a component to appear in the Narrow format, you must position two 
Narrow components consecutively.

 15 Click OK to save the component settings.

 16 To save the custom report, click Save.

The next stage in the procedure is to add another component (“Adding a 
Component to a Report” on page 43) or to filter report components 
(“Filtering Report Components” on page 76).



Part II • Configuring and Viewing User Reports

76

Filtering Report Components

You can filter reports so that they display certain objects only (for example, 
certain transactions, locations, or groups).

To set a component’s active filter settings:

 1 In the Custom Report Manager page, click the Component Filters button. 
Mercury Business Availability Center opens the Component Filters window 
or the Active Filters window, depending on the type of report.

Active filters are only available for certain component types. Note, too, that 
you can filter a Service Level Management report so that it includes 
transactions for specific locations and groups.

If a component is one of the five Global Statistics reports in Real User 
Monitor, the Component Filter button does not appear in the report.

 2 If available, select the profile whose active filters you want to modify. 

The Component Filters window does not display:

➤ transactions, locations, or groups that are excluded in the Report Filters 
or Global Report Filters pages for the current user

➤ measurements in SiteScope groups that the current user does not have 
permissions to view

For details on setting report filters, see “Configuring Report Filters Globally” 
in Platform Administration, “Report Filters” in Application Administration, and 
“Using the Real User Monitor Active Filters” in Using End User Management.

 3 If available, select a default view from the View by list.

For the Triage report, select the day for which you want to display data.

 4 Select or clear the active filter check boxes as required.

To include all items, select Include all. When Include all is selected, you 
cannot select or clear individual items.

 5 Click OK to save the settings.

 6 Click Save to save the report.
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Tip: To create meaningful custom reports, add a component for each critical 
element that you want to appear in the report, and then use active filters to 
focus on that element. For example, to focus on two business-critical 
transactions from two separate locations, create four components, and set 
the active filters to focus on each transaction from each location.

Note: If the current user does not have access permissions to the profile in 
the component (or to at least one of the profiles in a multi-profile 
component), or if the profile has been removed from the database, the user 
cannot edit component filters.

The next stage in the procedure is to define a header and footer. This step is 
optional. Continue to the next section.

Defining a Header and Footer for a Custom Report

You can add a custom header or footer to custom reports that you create. A 
custom header or footer overrides any default header or footer defined on 
the Default Header/Footer page. For details, see Chapter 9, “Default 
Header/Footer.”

The custom header and footer can include free text, HTML tags used to mark 
up the text, hypertext links, JavaScript, as well as references to external 
resources such as images, Flash files, and so forth. If you do not mark up the 
text, it is formatted according to the browser defaults.

Mercury Business Availability Center adds the HTML header to the report 
below the report title. Mercury Business Availability Center adds the HTML 
footer at the end of the report, immediately before closing the body tag.
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Note: Use caution when marking up the header and footer fields, as some 
HTML code may affect the behavior of Mercury Business Availability Center. 
For example, a linked URL may contain JavaScript that causes the URL to 
“break out” of frames. Make sure you use valid HTML.
It is recommended that you perform an external check of the HTML code 
used in the header and footer, as Mercury Business Availability Center does 
not perform any validity checks on the header and footer content.

To define a custom header or footer:

 1 In the Custom Report Manager, select Header/Footer to open the Report 
Header and Footer window.

 2 To define a custom header, type the required text and HTML code into the 
Header HTML box.

 3 To define a custom footer, type the required text and HTML code into the 
Footer HTML box.

 4 Click OK to save the header and/or footer.

 5 Click Save to save the settings.

To remove a custom header or footer:

 1 In the Custom Report Manager, select Header/Footer to open the Report 
Header and Footer window.

 2 To remove a custom header, delete the contents of the Header HTML box.

 3 To remove a custom footer, delete the contents of the Footer HTML box.

 4 Click OK.

 5 Click Save to save the settings.
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Modifying a Custom Report

You can modify components for which you have relevant permissions, 
using the Custom Report Manager.

Note: Permissions are granted by system administrators and can be enabled 
or revoked at any time. Thus, permissions to modify a custom report that 
you create could be removed by the administrator at a later time.

To edit a component:

 1 Click the Edit Component button to open the Edit Component window. 
Modify the settings as required, and click OK. For details on the Edit 
Component window, see “Adding a Component to a Report” on page 43.

 2 Click Save to save the settings.

To delete a component:

 1 Click the Delete Component button, and confirm that you want to delete 
the component.

 2 Click Save to save the settings.

To modify a report:

 1 From the Report list, select the report to edit.

 2 Click the Edit button beside the report name to open the Custom Report 
Properties window.

 3 Modify the Report title, Menu name, Time Period, or Report Auto-Refresh 
Settings as required.

 4 Select Insert a page break after each component when printing the report 
when you want to print reports where each component information starts 
on a new page.
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Note: This feature is only available on Internet Explorer (and not on other 
Web browsers such as Firefox or Mozilla).

To delete a report:

 1 In the Custom Report Manager, select the report to delete from the Report 
name list.

 2 Click the Delete button beside the report name and confirm that you want 
to delete the report.
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5
Additional Custom Reports

This chapter describes reports that cannot be accessed directly from any 
application but that can be added to custom reports to provide additional 
information. 

This chapter describes: On page:

Overview of Additional Custom Reports 82

Profile Summary Report 82

Response Time – 90th Percentile Report 83
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Overview of Additional Custom Reports

The additional custom reports display information about transaction 
response times and availability for Business Process Monitor and Client 
Monitor profiles.

For details on working with reports (choosing the time range, selecting the 
profile, saving and sharing reports, and so forth), see Chapter 1, “Working 
in Reports.”

The following reports are available: 

Profile Summary Report

The Profile Summary displays an overview of the transaction response time 
and availability for each Business Process or Client Monitor profile that you 
add to the report. For details, see “Workflow for Creating Custom Reports” 
on page 41.

If you apply active filters, only the selected transactions, locations, and 
groups are included.

Category Description For Details, See...

Profile Summary 
Report

Displays an overview of the transaction 
response time and availability for each 
Business Process or Client Monitor 
profile in the report.

page 82

Response Time – 
90th Percentile 
Report

Displays, for each indicated point in 
time, the response time value that 90% 
of all measured response time values are 
equal to or below.

page 83
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Click the profile name to generate a Transaction Analysis report for the 
profile. For details, see “Transaction Analysis Report” in Using End User 
Management.

The Profile Summary uses the following color coding:

Response Time – 90th Percentile Report

The Response Time – 90th Percentile report does not appear in any 
application and can be added only to custom reports to provide additional 
information. For details, see “Workflow for Creating Custom Reports” on 
page 41.

The Response Time – 90th Percentile displays, for each indicated point in 
time, the specific response time value that 90 percent of all measured 
response time values are equal to or below. You can view the data in either 
chart or table format.

Color Performance Transaction Availability

Green Each transaction’s average 
response time fell within the 
OK threshold level.

No transactions failed.

Yellow At least one transaction’s 
average response time fell 
within the Minor threshold 
level, but no transaction’s 
average response time fell 
within the Critical threshold 
level.

Not applicable.

Red At least one transaction’s 
average response time fell 
within the Critical threshold 
level.

At least one transaction failed.

Gray No transaction data is defined. Not applicable.
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When calculating each point along the chart (or value in the table), Mercury 
Business Availability Center considers all transaction instances between the 
given point in time and the following point. For example, when displaying 
the report in the “Day” resolution, Mercury Business Availability Center 
divides the x-axis (or table) per hour. The value at each point along the chart 
(or in each cell in the table) represents the 90th percentile for the following 
hour.

In the above chart, 90% of the transactions that ran between 9:00 AM and 
9:59 AM had response times equal to or below 23.757.

You add the Response Time – 90th Percentile report to custom reports using 
the Custom Report Manager. For details, see “Workflow for Creating Custom 
Reports” on page 41.

The Response Time – 90th Percentile data helps you identify response time 
problems and pinpoint their source. Because the data excludes response 
times above the 90th percentile (the highest 10 percent of response times), 
non-representative or non-typical transaction instances (for example, 
transactions that run during a server reboot) are eliminated. Thus, the data 
provides a more accurate picture of transaction performance over the 
defined time period.
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By breaking down the data by transaction, location, or group across 
different time frames, you can identify exactly where and when transaction 
response times are too slow. For example, you might determine that 
response times in the 90th percentile for transactions from a specific 
location are consistently high over the course of several hours. This might 
indicate a problem somewhere along the network between that location and 
the monitored Web site.

You can further analyze the Response Time – 90th Percentile data as 
described below:

➤ place your cursor over any small square along the chart to view a tooltip 
containing details about the specific response time value that 90 percent of 
all response time values were equal to or below.

➤ modify the report time frame and click Generate to generate the modified 
report.

➤ drill down in the chart view. Click any time point in the chart to increase 
the time resolution for the selected transaction, location, or group. Click 
any drill down link to the right of the report, to focus on that transaction, 
location, or group.

➤ drill down in the table view. Click any link in a column or row header to 
focus on a specific time frame, transaction, location or group.

➤ select the table view in the Custom Report Manager to display the report in 
table format.

The table displays, for each point in time, the specific response time value 
that 90 percent of all response time values were equal to or below. You can 
view the table broken down by transaction, location, or group.

➤ apply component filters in the Custom Report Manager. Click the 
Component Filters button, and select or clear check boxes to view the report 
filtered by specific transactions, locations, or groups.
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6
Trend Report Manager

This chapter explains how to create trend reports. Trend reports enable you 
to compare multiple measurements from several profiles. 

This chapter describes: On page:

Overview of Trend Reports 88

Workflow for Creating Trend Reports 89

Defining Trend Report Properties 90

Selecting Trend Report Measurements 91

Modifying Trend Report Measurements 95

Saving the Trend Report 96

Editing a Trend Report 97

Deleting a Trend Report 97

Previewing the Trend Report 97

Setting Up Time Comparisons 98

Defining a Header and Footer for a Trend Report 99

Adjusting the Trend Report Scale 100

Limitations 100
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Overview of Trend Reports

Trend reports enable you to compare multiple measurements from several 
profiles collected by Business Process Monitor, Client Monitor, and 
SiteScope, including transaction response time and availability data, 
WebTrace data (traceroute data for Client Monitor), and SiteScope data. In 
addition, you can add custom monitor data—including Real User Monitor 
data—to trend reports.

By combining measurements for several monitors on the same chart, you 
can analyze the relationship between transaction response time and 
availability, network and server health, and infrastructure machine 
performance over a selected time range.

The Trend Report Manager also enables you to compare the same set of 
measurements over two time periods (for example, you can compare 
measurements for the past hour and the hour before that).

You can also display data using different data aggregation methods and 
according to different groupings, and adjust the scale used when displaying 
a measurement. In addition, you can add a custom header and footer to the 
trend report.
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You access the Trend Report Manager from the User Reports tab in the 
Service Level Management, End User Management, or System Availability 
Management applications. 

You generate trend reports from the Trend Reports table on the Reports List 
page, accessed from the User Reports tab in the Service Level Management, 
End User Management, or System Availability Management applications. 
For details, see “Viewing Trend Reports” on page 119.

When Mercury Business Availability Center generates the trend report, it 
displays data in time segments that differ depending on the time granularity 
you select in the time range bar. For details on using the time range bar, see 
“Choosing the Tracking Range and Granularity” on page 8.

Reports are listed in alphabetical order.

Workflow for Creating Trend Reports

Use the following procedure to create a trend report:

 1 Create the trend report and give it a name. For details, see “Defining Trend 
Report Properties” on page 90.

 2 Select measurements to add to the report. For details, see “Selecting Trend 
Report Measurements” on page 91.

 3 This stage is optional. You can modify a measurement’s name, color or scale. 
For details, see “Modifying Trend Report Measurements” on page 95.

 4 Save the report. For details, see “Saving the Trend Report” on page 96.
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Defining Trend Report Properties

You select multiple measurements to display in the trend report. You can 
add up to 20 measurements to a trend report. 

Administrators can modify the maximum number of measurements 
displayed in a report. To modify this setting, select Admin > Platform > 
Setup and Maintenance > Infrastructure Settings. Select the Applications 
context and choose End User Management/System Availability 
Management from the list. Locate the End User Management/System 
Availability Management - Data table. Make the change to the value in the 
Max Trend Report Measurements setting. For details on the Infrastructure 
Settings Manager, see “Infrastructure Settings” in Platform Administration.

To define a trend report:

 1 From the User Reports tab in Applications > Service Level Management, End 
User Management, or System Availability Management, select Trend Report 
Manager.

 2 Click New to open the Trend Report Properties window.

 3 In the Report title box, type a descriptive name for the report.

 4 Click the Menu name box. By default, the report title appears in this box 
too. To specify a menu name that is different from the report title, enter it in 
the Menu name box. This is the menu name that appears in the Trend 
Reports list.

 5 To modify the title of the y-axis, specify the required value in the Y-axis title 
box. The text in this box is used for the Y-axis in report charts.

By default, the trend report chart’s y-axis uses a normalized scale to combine 
the different types of measurements. You can manually adjust the scale for 
individual measurements. For details, see “Adjusting the Trend Report Scale” 
on page 100.

 6 Click OK to register the trend report properties. The trend report properties 
are not saved until after you add at least one measurement to the report and 
click Save.

The next stage in the procedure is to select measurements. Continue to the 
next section.
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Selecting Trend Report Measurements

When you create a trend report, you use a set of filters to select the 
measurements to display in the merged chart. These filters differ per 
monitor category.

To select measurements:

 1 Click Add Measurements to add measurements to the trend report. Mercury 
Business Availability Center opens the Measurement Selection page.

 2 Select a monitor type from the Monitor type list:

➤ Business Process Monitor/Client Monitor. Transaction-related data 
collected by the Business Process Monitor/Client Monitor.

➤ WebTrace. WebTrace or traceroute data collected by the Business Process 
Monitor or Client Monitor.

➤ SiteScope. Infrastructure machine-related data collected by SiteScope.

➤ Real User Monitor. Network and server performance and availability data 
in real time collected by the Real User Monitor. 

Note that the data types listed under Real User Monitor (Pages, 
Transactions, End Users) are the same as the RUM Pages, RUM 
Transactions, and RUM End Users data types listed in the Custom 
monitor type list. Selecting them from the Real User Monitor monitor 
type list saves having to define measurement filters for them in the 
Measurement Filters page.

➤ Custom. Custom monitor data for which a filter has been defined in the 
Measurement Filters page.

Depending on the monitor type you choose, Mercury Business Availability 
Center displays the filters listed in the table below to determine which 
measurements are to appear in the trend report. You must select an entry 
from each list.
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To reduce the number of objects that are displayed in any list, enter a search 
string in the Contains box, and click the Filter button. Mercury Business 
Availability Center displays only those entries that contain the string. 

Monitor Category Filters

Business Process 
Monitor/Client Monitor

➤ Profile. Business Process/Client Monitor profiles.

➤ Transaction. Defined transactions in scripts 
assigned to profiles.

➤ Location. Defined host locations (machines on 
which Mercury Business Availability Center 
Business Process Monitor/Client Monitor Agent 
is running).

➤ Group. Defined groups to which hosts were 
assigned during profile creation.

➤ Counter. Transaction response time, transaction 
breakdown, and transaction availability data 
collected by Business Process Monitor/Client 
Monitor.

WebTrace ➤ Profile. Business Process/Client Monitor profiles.

➤ Location. Defined host locations (machines on 
which Mercury Business Availability Center 
Business Process Monitor/Client Monitor Agent 
is running).

➤ Counter. WebTrace/traceroute data collected by 
Business Process Monitor/Client Monitor.

SiteScope ➤ Profile. SiteScope profiles (one per SiteScope).

➤ Top Groups. Defined top-level SiteScope groups 
for the profile.

➤ Group Tree. Defined SiteScope groups and 
subgroups for the profile

➤ Measurement. SiteScope monitor and 
measurement information, displayed using the 
following syntax: monitor title | monitored 
server | counter.
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Real User Monitor ➤ Data Type. The type of data:

• Pages. The pages that have been configured 
for monitoring by Real User Monitor.

• Transactions. The transactions that have 
been configured for monitoring by Real User 
Monitor.

• End Users. The end users that have been 
configured for monitoring by Real User 
Monitor.

➤ Groups. Groups of pages/transactions/end users 
as defined in Monitor Administration. For 
details, see “Configuring the Real User Monitor” 
in End User Management Data Collector 
Configuration.

➤ Items. The pages/transactions/end users of the 
selected groups; this is the actual filter that is to 
be used.

➤ Measurements. All measurements defined for 
the selected data type.

Real User Monitor trend reports analyze the trend 
of performance and availability data for the servers, 
pages, transactions, and end users that you 
configure for monitoring. 

Monitor Category Filters
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 3 For each monitor category, Mercury Business Availability Center displays the 
counters (measurements) that are relevant to the selected groups or data 
types. Select the relevant counter (measurement).

 4 Select a data aggregation method from the Data aggregation method list.

Mercury Business Availability Center calculates the data to display for each 
time segment based on the data aggregation method you choose:

Average. For each time segment, calculates and displays the average of all 
data collected during that segment.

Maximum. For each time segment, displays the single highest data value 
that occurred during that segment.

Minimum. For each time segment, displays the single lowest data value that 
occurred during that segment.

Count. For each time segment, displays the number (count) of data values 
that occurred during that segment.

Sum. For each time segment, displays the sum of data values that occurred 
during that segment.

Custom ➤ Filter Category. Defined groups, created in the 
Measurement Filters page in Platform 
Administration, that help organize 
measurement filters into manageable groupings.

➤ Data Type. The type of data for which the 
measurement filter is created.

➤ Filter Name. The name of the measurement 
filter, created in the Measurement Filters page in 
Platform Administration, used to filter incoming 
custom data.

➤ Dimension. The name of a specific filter field.

➤ Dimension Values. A specific instance of a field 
in custom data chosen when defining a 
measurement filter. You use dimension values to 
group data in a trend report.

➤ Measurement. The available measurements for 
the selected data type.

Monitor Category Filters
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 5 If you chose the Business Process Monitor/Client Monitor monitor type, 
select a Group by setting. You can choose to group results by:

➤ Transaction. Results are shown per transaction.

➤ Location. Results are shown per host machine location.

➤ Group. Results are shown per group, as defined in the host properties.

 6 Click Add Measurements. Mercury Business Availability Center closes the 
Measurement Selection page and adds your selection(s) to the Selected 
Measurements table.

 7 Repeat the procedure to add measurements to the trend report.

The next stage in the procedure is to save the report. Continue to the next 
section.

Modifying Trend Report Measurements

You can change the name of the measurement, the measurement’s color, 
and its scale. You can also delete measurements from a report.

To change the measurement name

 1 Select the name in the Name box, and replace it with a more significant 
name.

 2 Click Save to save the trend report.

After a trend report is saved, you access it from the Trend Reports table in 
the Reports List page. For details, see “Viewing Trend Reports” on page 119. 

To change a measurement’s color:

By default, Mercury Business Availability Center assigns a unique color to 
each measurement you add to the trend report. Mercury Business 
Availability Center uses these colors when displaying the measurements in 
the trend report chart. If required, you can customize the color of any 
measurement.
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 1 Click the color swatch beside the measurement whose color you want to 
customize. Mercury Business Availability Center opens the Color Picker 
window.

 2 Select a color from the palette, or specify a color according to its 
hexadecimal value.

 3 Click OK. Mercury Business Availability Center updates the color swatch for 
the measurement.

 4 Click Save to save the trend report.

To change a measurement’s scale:

For details on adjusting scales, see “Adjusting the Trend Report Scale” on 
page 100.

 1 In the Scale list, select the required scale setting. 

 2 Click Save to save the trend report.

To delete a measurement:

 1 Locate the measurement you want to delete and click the Delete button.

 2 Click Save to save the trend report.

Saving the Trend Report

The next stage in the procedure is to save the trend report. 

To save the report:

 1 Verify that all the measurements you want to include are correct.

 2 Click Save to save the trend report.
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Editing a Trend Report

Use the following procedure to edit a trend report.

To modify report properties:

 1 From the Report name list, select the report to modify.

 2 Click the Edit button beside the report name to open the Trend Report 
Properties window.

 3 Modify the report title, menu name, or y-axis title settings as required.

 4 Click OK.

 5 Click Save to save the trend report.

Deleting a Trend Report

Use the following procedure to delete a trend report.

To delete a trend report:

 1 In the Trend Report Manager, select the report to delete from the Report 
name list.

 2 Click the Delete button beside the report name and confirm that you want 
to delete the report.

Previewing the Trend Report

You can preview the trend report chart directly from the Trend Report 
Manager (either before or after saving the report).

To preview a trend report:

 1 In the Trend Report Manager, click Preview. Mercury Business Availability 
Center generates the trend report and displays it in a new window.

Chart generation can take several minutes.

 2 You can change the report time range in the preview window. For details, 
see “Choosing the Tracking Range and Granularity” on page 8.
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Setting Up Time Comparisons

You can compare the measurements in a trend report for the selected time 
range to the same set of measurements over a similar time period, but for a 
different start date.

For example, to compare performance over two consecutive days, you could 
generate a trend report for one day starting Dec. 12 at midnight, and then 
generate the comparison data for one day starting Dec. 11 at midnight.

To generate comparison data:

 1 In the Trend Report Manager, click Set Time Comparison. Mercury Business 
Availability Center opens a calendar.

 2 Select the starting date and time for the comparison data, and click OK.

Mercury Business Availability Center displays the specified comparison time 
at the top of the Selected Measurements table. 

 3 Click Save to save the settings.

When you view the trend report with a time comparison activated, Mercury 
Business Availability Center displays the original data and the comparison 
data on two charts.

To adjust the comparison time:

 1 Click Set Time Comparison and select a different start date and time in the 
calendar.

 2 Click Save to save the settings.

To remove comparison data:

 1 Click Remove Time Comparison. Mercury Business Availability Center 
removes the time comparison information from the Selected Measurements 
table.

 2 Click Save to save the settings.
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Defining a Header and Footer for a Trend Report

You can add a header or footer to a trend report. This header or footer 
overrides any default header or footer defined for all reports. For details on 
adding a header and footer to all reports, see Chapter 9, “Default 
Header/Footer.”

For additional details on customizing headers and footers, see “Configuring 
a Report Header and Footer” in Platform Administration.

To define a header or footer:

 1 Select Header/Footer to open the Report Header and Footer window.

 2 To define a header, type the required text and HTML code into the Header 
HTML box.

To define a footer, type the required text and HTML code into the Footer 
HTML box.

 3 Click OK to save the header and/or footer.

 4 Click Save to save the trend report.

To view the defined header and footer in the report, click Preview, or select 
the report from the reports list.

To remove a header or footer:

 1 In the Trend Report Manager, select Header/Footer to open the Report 
Header and Footer window.

 2 To remove a header, delete the contents of the Header HTML box.

To remove a footer, delete the contents of the Footer HTML box.

 3 Click OK.

 4 Click Save to save the trend report.
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Adjusting the Trend Report Scale

Measurement values in the trend report are displayed along the y-axis using 
a normalized scale. By default, Mercury Business Availability Center 
automatically sets the scale factor for each measurement. If required, you 
can manually modify the scale factor for any measurement in the Selected 
Measurements table, for example, to better view multiple measurements 
whose data values span a wide range. For details, see “Modifying Trend 
Report Measurements” on page 95.

When you manually modify the scale factor, Mercury Business Availability 
Center scales measurement values by dividing the actual value by the value 
chosen in the scale list. Thus, a value of 100 with a scale setting of 0.1 is 
shown as 1000 along the y-axis. A value of 100 with a scale setting of 10 is 
shown as 10 along the y-axis.

For example, if at a given point in time Measurement A (whose scale value is 
set to “Auto”) has a value of 10 and Measurement B (whose scale value is set 
to 0.1) has a value of 90, the y-axis displays a range from 0-1000 to 
accommodate both values. If both measurements’ scale settings are set to 
“Auto,” the y-axis values ranges from 0-100.

Limitations 

➤ Permissions are granted by system administrators and can be enabled or 
revoked at any time. Thus, permissions to modify a trend report that you 
create could be removed by the administrator at a later time.

➤ If the total number of characters of all measurement names in the trend 
report is larger than the maximum length of the URL configured in the 
server, the trend report may not be generated or previewed. If this happens, 
reduce the number of measurements in the trend report or shorten the 
measurement names.

➤ Transactions whose response times exceed their outlier value (set in 
Transaction Threshold settings in Monitor Administration) are always 
displayed in trend reports as failed transactions, even if the Ignore outlier 
data in reports setting is selected for the profile to which the transactions 
belong.
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7
Custom Link Manager

You can add custom links to the Reports List page using the Custom Link 
Manager. Custom links enable you to open a Web page in the same browser 
window. 

This chapter describes: On page:

Defining a Custom Link 102

Viewing the Linked Site 103

Deleting a Custom Link 103
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Defining a Custom Link

Use the following procedure to define a custom link.

To define a custom link:

 1 From the User Reports tab in Applications > Service Level Management, End 
User Management, or System Availability Management, select Custom Link 
Manager.

In the Menu name box, type a descriptive name for the link. After saving the 
link, Mercury Business Availability Center displays this name in the Custom 
Links table.

 2 In the Target URL box, specify the URL of the site to which you want to link.

Note: When entering the Target URL, do not enter a URL that is redirected. 
If the link is accessed, a redirection may cause a runtime error or the 
application to log out. Enter only URLs that are accessed directly upon 
linking. 

 3 Click the Save button. Mercury Business Availability Center adds the saved 
link to the Custom Links table on the Custom Link Manager page and to the 
Custom Links table on the Reports List page.

Links are sorted alphabetically in the Custom Links table, according to the 
defined menu name.

Note: If the specified Web page includes JavaScript code that attempts to 
access the top frame, the browser displays an “access denied” error. To avoid 
this issue, set the browser to ignore JavaScript errors.
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Viewing the Linked Site

Use the following procedure to view the linked site.

To view the linked site:

Select one of the following:

➤ in the Custom Link Manager, click the link to open the defined Web page in 
a new browser window

➤ from the Custom Links table on the Reports List page, click the link to open 
the defined Web page in the same window

Deleting a Custom Link

Use the following procedure to delete a custom link.

To delete a custom link:

In the Custom Link Manager, click the Delete button beside the link you 
want to delete, and confirm that you want to delete the link.

Note: You cannot modify a custom link. To modify a custom link name or 
URL, recreate it with the modified information and delete the old link.
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8
Integrating Microsoft Excel Reports in 
Mercury Business Availability Center 

You can build and view customized reports in Mercury Business Availability 
Center that take advantage of the charting abilities of Microsoft Excel, to 
display various types of data collected by Mercury Business Availability 
Center data collectors. The reports can be viewed with Microsoft Excel or 
any spreadsheet program capable of reading files with the .xls format.

Note to Mercury Managed Services customers: Contact Mercury Managed 
Services Support for details on implementing Microsoft Excel reports in 
Mercury Managed Services.

This chapter describes: On page:

Workflow for Creating Microsoft Excel Reports 106

Create a Microsoft Excel Web Query File 107

Create a Report with Microsoft Excel 108

Upload the Microsoft Excel Report to Mercury Business Availability 
Center

109

View the Microsoft Excel Report in the Excel Report Page 109

Managing Excel Reports 110

Example of Web Query 111

Excel Report Limitations 112
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Workflow for Creating Microsoft Excel Reports

Use the following procedure to create Microsoft Excel reports that include 
Mercury Business Availability Center data:

 1 Write a query that retrieves data from the Mercury Business Availability 
Center profile database. For details, see “Working with Data APIs” in 
Integrating with Third-Party Applications.

 2 Save the query in a Web Query file. For details, see “Create a Microsoft Excel 
Web Query File” on page 107.

 3 Create a Microsoft Excel report. For details, see “Create a Report with 
Microsoft Excel” on page 108.

 4 Upload the report to Mercury Business Availability Center. For details, see 
“Upload the Microsoft Excel Report to Mercury Business Availability Center” 
on page 109.

 5 View Microsoft Excel reports in Mercury Business Availability Center. For 
details, see “View the Microsoft Excel Report in the Excel Report Page” on 
page 109.
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Create a Microsoft Excel Web Query File

You create a text file with an .iqy (IQY) extension that you then import into 
Excel.

To create an .iqy file:

 1 Open an empty file in a text editor and copy the following content into the 
file:

 2 Locate the query you created and place it in the file instead of the line 
<query_url_goes_here>. 

 3 Save the text file with an .iqy (IQY) extension.

For an example of a query that extracts data from the profile database, see 
“Example of Web Query” on page 111.

The next stage of the procedure is to create a Microsoft Excel report. For 
details, see the next section.

WEB
1
<query_url_goes_here>

Selection=EntirePage
Formatting=None
PreFormattedTextToColumns=True
ConsecutiveDelimitersAsOne=False
SingleBlockTextImport=False
DisableDateRecognition=False
DisableRedirections=False
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Create a Report with Microsoft Excel 

The next stage of the procedure is to create a Microsoft Excel report. 

To create a Microsoft Excel report:

 1 Open a new Microsoft Excel file.

 2 Select cell A1.

 3 In Microsoft Excel 2002 or 2003, select Data > Import External Data > 
Import Data. Microsoft Excel opens the Select Data Source dialog box. Select 
the .iqy file you created (“Create a Microsoft Excel Web Query File” on 
page 107) and click Open. Excel opens the Import Data dialog box.

In Microsoft Excel 2000, select Data > Get External Data > Run Saved Query. 
Microsoft Excel opens the Run Query dialog box. Select the .iqy file and 
click Get Data. Excel opens the Returning External Data to Microsoft Excel 
dialog box.

 4 Select Existing worksheet, and check that the value =$A$1 is selected.

 5 Click Properties. Microsoft Excel opens the External Data Range Properties 
dialog box.

 6 Make sure the following settings are configured:

➤ refresh data on file open

➤ remove external data from worksheet before saving

➤ overwrite existing cells with new data, clear unused cells

 7 Click OK. Microsoft Excel closes the External Data Range Properties dialog 
box and displays the Import Data dialog box (Returning External Data to 
Microsoft Excel dialog box in Excel 2000).

 8 Click OK to retrieve the data.

 9 Use Microsoft Excel’s charting features to format the report, as required.

 10 Name the file and save the Microsoft Excel workbook to a temporary 
location.

The next stage of the procedure is to upload the Microsoft Excel file to 
Mercury Business Availability Center. For details, see the next section.
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Upload the Microsoft Excel Report to Mercury Business 
Availability Center 

The next stage of the procedure is to upload the Microsoft Excel file to 
Mercury Business Availability Center. 

To upload a Microsoft Excel report:

 1 From the User Reports tab in Applications > Service Level Management, End 
User Management, or System Availability Management, select Excel 
Reports.

 2 Click New Excel Report to open the Excel Report Properties window.

 3 In the Report name box, type the name for the report as you want it to 
appear in the Reports table on the Excel Reports page.

 4 In the Description box, type the description for the report as you want it to 
appear in the Reports table on the Excel Reports page.

 5 In the Excel file box type the path to the saved Excel file you want to add, or 
use the Browse function to browse to the file.

 6 Click Save to upload the file to Mercury Business Availability Center.

The report is now ready to be viewed by you or your users. For details, see 
the next section.

View the Microsoft Excel Report in the Excel Report Page

You or your users can view Excel reports in Microsoft Excel or any 
spreadsheet program capable of reading files with an .xls format.

To view an Excel report:

 1 From the User Reports tab in Applications > Service Level Management, End 
User Management, or System Availability Management, select Excel 
Reports.

 2 Click the report you want to view. Mercury Business Availability Center 
opens the report in Microsoft Excel. You must have Microsoft Excel installed 
on the machine on which you are viewing Mercury Business Availability 
Center.
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Managing Excel Reports

You can edit properties for, as well as delete, Excel reports listed in the Excel 
Reports page.

To edit Excel report properties:

 1 From the User Reports tab in Applications > Service Level Management, End 
User Management, or System Availability Management, select Excel 
Reports.

 2 Click the Edit button beside the Excel report you want to edit, to open the 
Excel Report Properties window. 

 3 Modify the name and description properties as required.

 4 To upload an updated version of the Excel file (and overwrite the existing 
file on the Mercury Business Availability Center server), specify the file to 
upload.

 5 Click Save to save the settings.

To delete an Excel report:

 1 From the User Reports tab in Applications > Service Level Management, End 
User Management, or System Availability Management, select Excel 
Reports.

 2 Click the Delete button beside the Excel report you want to delete, and 
confirm that you want to delete the Excel report.
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Example of Web Query

The following is an example of a typical Web query file. This example 
illustrates the retrieval of a list of rum_server_t samples that failed in any 
given day:

To use this example:

 1 Type or copy the text from the above example into a text editor.

 2 Edit the URL beginning on the third line of the file as required. Leave all 
other values as shown.

 3 Save the file with an .iqy extension.

WEB
1
http://myServer/topaz/gdeopenapi/GdeOpenApi?method=getData&user=a
dmin&password=admin&query=select time_stamp, engine_name, 
server_name from rum_server_t where availability=0 and total_hits > 0 
and time_stamp>1041379200 and time_stamp<1136197020

Selection=EntirePage
Formatting=None
PreFormattedTextToColumns=True
ConsecutiveDelimitersAsOne=False
SingleBlockTextImport=False
DisableDateRecognition=False
DisableRedirections=False
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Excel Report Limitations

➤ Users who have permissions to view Microsoft Excel reports but who do not 
have permissions on specific profiles are able to view data from those 
profiles if they are included in an Excel report.

➤ Microsoft Excel reports cannot return more than 10,000 records due to an 
Microsoft Excel limitation when using Web queries. Possible workarounds 
include:

➤ split request to several consecutive queries

➤ group data using larger time range chunks

➤ use filter parameters to fetch specific data
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Default Header/Footer

This chapter explains how to add a header and footer to user reports 
(custom and trend reports), for example, to add a corporate logo and 
address. 

This chapter describes: On page:

Format of Default Headers and Footers 114

Which Header or Footer is Displayed in Reports 114

Defining a Default Header and Footer 115

Removing a Default Header or Footer 116
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Format of Default Headers and Footers

Headers and footers can include free text, HTML tags used to mark up the 
text, hypertext links, JavaScript, as well as references to external resources 
such as images, Flash files, and so forth. If you do not mark up the text, it is 
formatted according to the browser defaults.

Mercury Business Availability Center adds the header to the report below 
the report title and the footer at the end of the report. (In the HTML file, the 
footer is inserted immediately before the </body> tag).

Which Header or Footer is Displayed in Reports

Mercury Business Availability Center displays the header and footer you 
define here in all custom and trend reports, on condition that these reports 
do not already include a header and footer. When a header and footer is 
defined for a specific report, Mercury Business Availability Center displays 
that header and footer, and not the header and footer defined here. For 
details, see “Defining a Header and Footer for a Custom Report” on page 77 
and “Defining a Header and Footer for a Trend Report” on page 99.

You can also add a header and footer to all reports through the 
Infrastructure Settings Manager. To change the headers or footers, select 
Admin > Platform > Setup and Maintenance > Infrastructure Settings, click 
Foundations, select Reporting and locate the Display Header and Display 
Footer in the Reporting – Display entry in the table. For details on editing 
infrastructure settings, see “Editing Infrastructure Settings” in Platform 
Administration. 
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Defining a Default Header and Footer

Note: Use caution when marking up the header and footer fields, as some 
HTML code may affect the behavior of Mercury Business Availability Center. 
For example, a linked URL may contain JavaScript that causes the URL to 
“break out” of frames. Make sure you use valid HTML. 

It is recommended that you perform an external check of the HTML code 
used in the header and footer, as Mercury Business Availability Center does 
not perform any validity checks on the header and footer content.

To define a header or footer:

 1 From the User Reports tab in Applications > Service Level Management, End 
User Management, or System Availability Management, select Default 
Header/Footer.

 2 To define a header, type the required text and HTML code in the Header 
HTML box.

To define a footer, type the required text and HTML code in the Footer 
HTML box.

The total number of characters entered into the header or footer definition 
cannot exceed 2000 (or 4000 when using ASCII VARCHAR data types in the 
Mercury Business Availability Center management database).

 3 Click Preview to preview the header and/or footer. The preview renders the 
HTML code only, and does not run any JavaScript, if included.

 4 Click Save to save the header and/or footer.

To test the header and footer in a report, preview an existing custom or 
trend report that does not include a header or footer, or create a new custom 
or trend report.
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Removing a Default Header or Footer

Use the following procedure to remove a header or footer.

To remove a header or footer:

 1 From the User Reports tab in Applications > Service Level Management, End 
User Management, or System Availability Management, select Default 
Header/Footer.

 2 To remove a header, delete the contents of the Header HTML box.

To remove a footer, delete the contents of the Footer HTML box.

 3 Click Save.
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Report Lists

This chapter explains how to use the Reports List page to view user reports.

This chapter describes: On page:

Accessing User Reports on the Reports List Page 118

Viewing Custom Reports 118

Viewing Trend Reports 119

Viewing Custom Links 120

Accessing User Reports Using a URL 121
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Accessing User Reports on the Reports List Page

The Reports List page displays all the defined custom reports, trend reports, 
and custom links that have been defined in the system, that the current user 
has permissions to view. The name of the owner of each report (that is, the 
user that created the report) is also displayed. 

For details on working with reports (choosing the time range, selecting the 
profile, saving and sharing reports, and so forth), see “Working in Reports” 
on page 3.

This section includes the following topics:

➤ “Viewing Custom Reports” on page 118

➤ “Viewing Trend Reports” on page 119

➤ “Viewing Custom Links” on page 120

➤ “Accessing User Reports Using a URL” on page 121

Viewing Custom Reports

From the Custom Reports table, you can generate and edit custom reports. 
Custom reports include components—individual application reports that 
enable you to focus on the data you are most interested in tracking.

For details on creating custom reports, see “Custom Report Manager” on 
page 39.

Tip: You can build a URL that enables you to view a custom report without 
having to access the Reports List page. For details, see “Accessing User 
Reports Using a URL” on page 121.
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To generate a custom report:

In the Custom Reports table, click the Generate button beside the report 
you want to generate. The report is generated for the default time range.

You can regenerate the report for a different time range, by modifying the 
time range settings as required and clicking Generate.

To edit a custom report:

 1 Click the Edit button beside the report you want to edit to open the Custom 
Report Manager. For details, see “Custom Report Manager” on page 39.

 2 Make the required changes and save the report.

To schedule a custom report:

 1 Click the Schedule button beside the report you want to schedule. Mercury 
Business Availability Center opens the Scheduled Report page. 

 2 Create a scheduled report. For details, see “Scheduled Reports” in Platform 
Administration.

 3 Return to the Reports list by clicking the link at the top of the page.

Viewing Trend Reports

From the Trend Reports table, you can generate and edit trend reports. Trend 
reports enable you to compare multiple measurements from several profiles. 
For details on creating trend reports, see “Trend Report Manager” on 
page 87.

Tip: You can build a URL that enables you to view a trend report without 
having to access the Reports List page. For details, see “Accessing User 
Reports Using a URL” on page 121.
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To generate a trend report:

 1 In the Trend Reports table, click the Generate button beside the report you 
want to generate. The report is generated for the default time range.

 2 To regenerate the report for a different time range, modify the time range 
settings as required and click Generate.

Note: When viewing a trend report for a profile whose name was changed, if 
no data is displayed in the report, try logging in to Mercury Business 
Availability Center again.

To open a trend report for editing:

 1 Click the Edit button beside the report you want to edit to open the Trend 
Report Manager. For details, see “Trend Report Manager” on page 87.

 2 Make the required changes and save the report.

To schedule a trend report:

 1 Click the Schedule button beside the report you want to schedule. Mercury 
Business Availability Center opens the Scheduled Report page. 

 2 Create a scheduled report. For details, see “Scheduled Reports” in Platform 
Administration.

 3 Return to the Reports list by clicking the link at the top of the page.

Viewing Custom Links

From the Custom Links table, you can display a Web page in the same 
browser window. For details on creating custom links, see “Custom Link 
Manager” on page 101.

To open a custom link:

In the Custom Links table, click the link you want to open. The Web page 
opens in the page.
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Accessing User Reports Using a URL

You can build a URL that opens a defined user report directly in the browser, 
without being located in the Mercury Business Availability Center context.

Build the URL using the following syntax: 

The parameters whose values must be provided are described below:

➤ <ServerName>. The name of the Mercury Business Availability Center server 
(Centers Server in a distributed architecture).

➤ <filterProfileId>. Any valid profile ID listed in the SESSION_ID column in 
the SESSIONS table of the management database.

➤ <timeFrame>. Any one of: 
Hour/Day/Week/Month/LastHour/LastDay/LastWeek/LastMonth.

➤ <stepUnit>. Any one of: Minute/Hour/Day/Month.

➤ <stepValue>. Value of stepUnit (for example, if timeframe of every 1 day is 
required, and stepUnit=Day, set stepValue=1).

➤ <login_name>. Valid user login name.

➤ <login_password>. Password for specified login name.

http://<ServerName>/topaz/OfflineReportsServlet?createSession=true
&filterProfileId=<filterProfileId>
&actionForward=report
&timeFrame=<timeFrame>
&stepUnit=<stepUnit>
&stepValue=<stepValue>
&requestType=offline
&userlogin=<login_name>
&userpassword=<login_password>
&session_id=<session_id>
&autoUpdatePastTime=true
&gmtOffset=<gmtOffset>
&useVIP=true
&startTime=<startTime>
&endTime=<endTime>
&skipNavBar=true
&reportName=Report_<report_ID>
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➤ <session_id>. Same as filterProfileId.

➤ <gmtOffset>. GMT offset in minutes.

➤ <startTime>. Start time for the report in format YYYYMMDDHHmm (not 
needed if using timeFrame=LastHour/LastDay/LastWeek/LastMonth). Note 
that months are numbered starting from 0, so January is 00 and December is 
11.

➤ <endTime>. End time for the report (same details as start time).

➤ <report_ID>. The CR_CUSTOM_REPORT_ID value for the report, as 
specified in the CUSTOM_REPORTS table in the management database.

For example:  

http://myserver/topaz/OfflineReportsServlet?createSession=true
&filterProfileId=1
&actionForward=report
&timeFrame=Week
&stepUnit=Day
&stepValue=1
&requestType=offline
&userlogin=admin
&userpassword=admin
&session_id=1
&autoUpdatePastTime=true
&gmtOffset=120
&useVIP=true
&startTime=200600010100
&endTime=200601010100
&skipNavBar=true
&reportName=Report_1
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Report Repository

This chapter explains how to search for and view reports in the report 
repository. You can view saved reports in Dashboard, Service Level 
Management, and End User Management (Triage report only). For details on 
saving reports to the report repository, see “Saving a Report to the Report 
Repository” on page 29. 

This chapter describes: On page:

The Report Repository Page 124

Searching for a Report in the Report Repository 125

Editing Report Details 126

Deleting a Report from the Repository 126

Editing Settings with the Infrastructure Settings Manager 127
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The Report Repository Page

The Report Repository page displays all reports previously saved in 
Dashboard, Service Level Management, and End User Management (Triage 
report only). For details on searching for a report, see “Searching for a Report 
in the Report Repository” on page 125.

To access the report repository:

➤ In Dashboard: Applications > Dashboard > Reports > Report Repository.

➤ In Service Level Management: Applications > Service Level Management > 
Report Repository.

➤ In End User Management: Applications > End User Management > Report 
Repository.

The Report Repository page:

The Report Repository page includes the following components: 

Report Name. The name given to the report when it was saved to the 
repository. For details on editing the name, see “Editing Report Details” on 
page 126. 

➤ To view the report in PDF format, click the report name.

➤ To view the report’s name and description in full, hold the cursor over 
the report name.

Report Type. The name of the report type.

Private. 

➤ No: the report is public and any user can view, edit, or delete the report 
from the repository. 

➤ Yes: only the user or Superuser-level administrator can view, edit, or 
delete the report from the repository. 

(For Mercury Managed Services customers: Yes: only the user, superuser, 
operator, customer superuser, and customer administrator can view, edit, 
or delete the report from the repository.) 

Report Creation Time. The time at which the report was saved to the 
repository.
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Actions. You can edit or delete a report by clicking the appropriate button. 
For details, see “Editing Report Details” on page 126 and “Deleting a Report 
from the Repository” on page 126. You can use the buttons at the bottom of 
the window for Select All, Clear All, and Invert Selection.

You can sort the list by any column: An arrow next to a title shows by which 
column the reports are sorted, and also the direction in which the column 
has been sorted (that is, ascending or descending).

➤ To view more reports, click the Next page or Last page buttons.

➤ To view previous reports in the list, click the Previous page or First page 
buttons.

Searching for a Report in the Report Repository

Reports previously saved to the repository can be viewed in Dashboard, 
Service Level Management, or End User Management, no matter in which 
application they were created.

To search for a report:

 1 Access the report repository: 

➤ In Dashboard: Applications > Dashboard > Reports > Report Repository.

➤ In Service Level Management: Applications > Service Level Management 
> Report Repository.

➤ In End User Management: Applications > End User Management > 
Report Repository.

 2 Locate the report directly in the list, or search for the report, either by its 
report type or by its name.

➤ To search for a report by its report type, click the Report Types link. In 
the window that opens, select the report. To make your selection, you 
can also use the buttons at the bottom of the window for Select All, Clear 
All, and Invert Selection. Click OK, or click Cancel to close the window 
without choosing a report.
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➤ To search for a report by its name, enter the name in the Search by name 
field, and click Search Repository. You can type an asterisk (*) to replace 
characters.

All reports answering the search criteria are displayed in the list. For details, 
see “The Report Repository Page” on page 124.

 3 To view the report in PDF format, click the report name.

Editing Report Details

You can change several properties of the report in the repository (for 
example, the report’s name), but not the data itself.

To edit a report:

 1 Locate the report in the report repository and click its Edit button to open 
the Report Repository window.

 2 Make changes to the name and description. Choose whether the report is to 
be private or public (for details, see page 124). Click OK, or click Cancel to 
close the window without saving the changes.

Deleting a Report from the Repository

You can delete a saved version of a report, but not the data itself.

To delete a report:

 1 Locate the report in the report repository and click its Delete button.

 2 Click OK to the message, or click Cancel to close the message without 
deleting the report.
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Editing Settings with the Infrastructure Settings Manager

Caution: Many of the settings in the Infrastructure Settings Manager should 
not be modified without first consulting Mercury Customer Support or your 
Mercury Services representative. Modifying certain settings can adversely 
affect the performance of Mercury Business Availability Center. 

Administrators with an advanced knowledge of Mercury Business 
Availability Center can customize certain report repository settings, such as 
the maximum number of reports that can be saved to the repository, the 
maximum number of rows that are retrieved from the database when the 
user clicks the Search Repository button, and the number of reports to 
display in one page. 

To access the Infrastructure Settings Manager, select Admin > Platform > 
Setup and Maintenance > Infrastructure Settings. Select the Foundations 
context and choose Reporting from the list.

For details on editing infrastructure settings, see “Editing Infrastructure 
Settings” in Platform Administration. For details on using the page toolbar, 
see “Navigating Within Report Pages” on page 16.
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